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INTRODUCTION/TRAINING AND SUPPORT

Course Set-up

At Pearson, we understand the challenges of teaching with a new technology. For
face-to-face, online, hybrid, modular, or other course delivery methods, this allinclusive User Guide will help to ensure a successful teaching and learning
experience.

Navigation

Use this guide as a self-paced training course or click right to your topic of choice
for just-in-time answers. This searchable, interactive guide includes:
 Step-by-step instructions illustrated with screen grabs
 Embedded training videos covering a variety of topics, from initial
registration and login to posting final grades
 Best Practices, Tips, Keys for Success, & First-semester implementation
suggestions
…And much more!
This User Guide is available to you 24/7, as often as needed, throughout your
course. So come back often!

Gradebook

Virtual Classroom Sessions Led by an Experienced User
Several regularly scheduled, live training sessions help you get the most out
of MyMISLab. Virtual Classroom sessions are offered year-round, and you
can attend as many sessions as you need.
The My Business School Community
Connect anytime with Business educators and members of the Pearson
Faculty Advisory Network—a network of educators teaching with technology
using MyLab/Mastering—via the My Business School Community site for
advice, best practices, and ongoing support.

Student Experience

First Day of Class Resources
Pearson provides the First Day of Class Resources that will help you get
your students up and running quickly with MyMISLab.
24/7 Customer Support
At our Support Home Page, you and your students can access phone
support, 24/7 chat and email support, and an extensive, searchable
knowledge base with how-to articles. Also accessible from mobile devices.
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Registration

All of the resources outlined below can be accessed on the Tours and Training or
Support tab of www.mymislab.com.

Registration

How Do I Get started?
Request your instructor access code

Course Set-up

You must have an instructor access code to get started. If you don’t have one, you
can request one online. Click here for the MyLab / Mastering home page, then
click Educator under Register.
Under Request a Code, select your location, and provide the information
requested. We’ll verify your request and email your single-use access code within
four business days of request approval.

Navigation

Or, you can contact your sales representative to obtain an access code.

Order textbooks and student access code kits

Gradebook

• The textbook bundled with a student access card
• A standalone access code kit: MyLab Access with eText
• Additional book and code bundles are available. Ask your sales rep for the best
combination for your needs.
Your students can also pay online during registration. If they chose to use a credit
card or PayPal account to pay during registration, they don’t need an access code.
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If your course has multiple student ISBNs representing different packages or print
formats, your sales representative can help you identify the correct ISBN(s) for
your course.
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Your bookstore needs to use the correct ISBN(s) when ordering. For most courses,
they can order one or both of the following:

Registration

Students need to redeem the individual, course-specific student access code to
register for your online course. This code can be redeemed only once — at the
moment of registration.

Register
1. On the MyLab and Mastering home page, click Educator under
Register.
2. On the Educator screen, click the Register button.
3. Read the license agreement and click I Accept to continue.
4. Sign in or create an account:
- Click Yes under Do You Have a Pearson Education Account to sign in
with your existing Pearson account login name and password.
- Click No to create a Pearson account. Enter a login name and password.
Click Check Availability to verify the new login name is available for use.
- Click Not Sure to search for your account.
5. Enter your access code in the boxes provided or click Switch to a single box
to paste in the access code.
6. Enter or verify your contact information.
7. From the Confirmation page, click Login to go to the MyLab / Mastering home
page. In the MyLab / Mastering New Design section on the left side of the
page, click Create your New Course to set up the course section(s) you will be
teaching. See Creating Your New Design Course for more information.

Registration

MyLab/Mastering Account Home Page

Course Set-up

After you log in you will come to your MyLab/Mastering Courses page. This page is
the central location for all of your MyLab/Mastering courses and Pearson
resources. You will create your MyLab New Design courses here and access your
other MyLab courses.
There are four areas on this page:

Gradebook

Keys to Success: Logging out prevents the next user of the computer from
accessing your MyLab/Mastering New Design instructor resources, such as the
Gradebook. This is especially important if you are using a public computer, such as
in a computer lab or shared office environment.

Assignments

Registration

The top right corner of the MyLab/Mastering Courses page provides links to:
 Account - Enables you to manage your Pearson account by editing your
personal information.
 Help & Support - Opens a page with links to online Instructor or Student
Help and MyLab/Mastering New Design support resources.
 Sign Out - Ends your session.

Navigation

1. MyLab/Mastering New Design - Lists all the MyLab/Mastering New Design
courses you are teaching and where you will create your New Design
courses.
2. Your Courses & Products - To access any of your traditional MyLab
courses click on the MyLab Courses link in this area.
3. Announcements - Displays general announcements from Pearson
Education and provides timely information about each of your courses.
4. Need Help? - Provides links to resources to help you Get Started, Access
Support and Access Pearson Resources.

Student Experience
Course Mgmt.
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Creating Your New Design Course
Warning: If you have chosen an integrated set up with your local
LMS, please follow those specific instructions for creating linked
courses. These instructions will not apply.
From your MyLab/Mastering Courses page you will create your
course sections. You can make copies of your course, and you can
also allow for other instructors to copy your course. See section on
Program Admin/Coord if you are a Program Administrator or Program
Coordinator to learn more about your specific options.
Best Practice: Set up a separate course ID for each section of the course that
you are teaching. Managing your gradebook and due dates will be much easier for
you by doing this. See Create/Copy Additional Courses and Sections to learn
more copying courses and creating sections.
To create your MyMISLab New Design course:
• Click Create your New Course or Create/Copy Course located in the
MyLab/Mastering New Design area.
• On the Create or Copy a Course page, search for course materials:
o Select Search Course Materials. Enter the textbook Author, Title or
ISBN
OR
o Select Browse by Discipline. Click the dropdown menu to locate
your discipline. You can leave All Publishers selected or narrow you
search by selecting a specific imprint.
• Click Go. Review the contents listed under the titles for the types of content
included in the course material.
• Click Select Course Materials

Registration

To specify course information:
1. Enter the Course Name.

Navigation
Gradebook

4. Select Course Enrollment Dates:
 For Enrollment Start Date, click the calendar icon to select the month,
day, and year when you want students to start enrolling in your course. The
default is the current date.
 For Enrollment End Date, click the calendar to select the month, day, and
year when you want students to stop enrolling in your course.

Student Experience

Best Practice: To reduce the likelihood of duplicate student enrollments, set
the enrollment end date to align with your school's drop/add period, or other
class start period. The enrollment end date can be revised for late student
enrollment, if necessary.
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Registration

3. Select a course type:
 For standard courses,
in most cases you will
select For Student
Enrollment.
 Select For Instructor
Use Only if you do not
intend to enroll
students in the course.
This type of course can
be modified and copied
to create other courses.
(If you are creating a
For Instructor Use
Only course, the
Course Enrollment
Dates section is grayed
out. Skip to step 5.)

Course Set-up

2. (Optional) Enter a course Description to help distinguish this course from
another course, for example, the course number and section, or when the
course meets.

5. Select Course Duration Dates:
 For Course Start Date, use the calendar to select the month, day, and year
when you plan to begin teaching the course. The default is the current date.
 For Course End Date, use the calendar to select the month, day, and year
when you want to close student access to your course. Students will be
unable to access this course beyond the maximum course end date of 24
months after creation. As an instructor, however, you will have access to the
course until it is deleted.
When the course reaches its maximum end date, it enters a 3-month course
retirement phase. At the end of this phase, email alerts remind you that
your course is flagged for deletion, and provide information on how to make
a copy of your course for reuse after the original course is deleted.
Best Practice: Leave the course start date default for the current date and set
the course end date a month or so after the last day of classes to allow
students time to complete makeup work, or to allow you time to copy course
materials you plan to use again.
6. Under Make Available For Other Instructors To Copy, select:
 Available For Copy to allow other instructors to copy your course.
 Unavailable For Copy if you do not want other instructors to be able to
copy your course.
7. Click Create Course Now.
A Confirmation-Request
Received page will provide you
with your unique Course ID,
usually consisting of your last
name and five numbers (for ex:
smith12345). Course IDs also
appear below each course name
in the MyLab / Mastering New
Design courses list on the
courses page. You can print this
page for your records. At the
bottom of the page, click Back
to your Courses page.

Registration
Course Set-up

On your MyLab/Mastering Courses page, the clock icon indicates that your course
is being prepared. When your course is ready, you will receive an email. The
course is created in as little as an hour or up to one day, depending on the size of
the course materials you selected and the number of course creation requests in
the queue. You do not need to stay signed in or be connected to the Internet while
your course is created.
You will receive an email when you course is ready. Included in this email is a
student registration handout populated with your course information including the
Course ID that you can email or give to your students. You can also access this
handout by clicking the Details link next to your course name on the courses list
on your account home page.

Navigation

After your course is created, you can communicate the course ID and student
registration handout to students so they can enroll in your course (for courses set
for Student Enrollment). Do not send the course ID to students if course creation
fails.

Assignments

Registration

Gradebook
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Program Administrators and Coordinators
Program Administrators and Coordinators often have different needs and
objectives than an individual instructor. If you are a program administrator or
coordinator creating courses for other instructors, you have a choice between
creating all of the course sections for every instructor in your own account and
creating one standard individual course with copy settings set to ―available to
copy‖. Read below to understand which option might better suit your needs.
Create All Sections in your Own Account
Choosing to create all of the sections in your own account allows you the ability to
monitor and analyze results from all sections of the course. Both you and the
section instructors will have access to the course as an instructor, but section
instructors will not have access to the course roster unless you enable that
privilege when you upgrade their role. This option is the best choice for
administrators and coordinators that need to monitor and analyze results from all
courses.
In this scenario, you would create a standard course, set up the course and
finalize your customizations and organization, and then create multiple copies for
each section being taught using the Make Multiple Sections or Copies of a
Course feature.
Once the sections are
created, you can divvy out
the corresponding course
IDs to each instructor. See
Section
Instructors/Teaching
Assistants
for
instructions to enable the
instructors’
access
to
these section course IDs.

Best Practice: When creating multiple copies of your course at one time, name
the courses with identifiers such as the instructors’ last names or the meeting
days/time for the course.

Registration
Course Set-up

Standard course set to “available to copy”
Choosing to create a standard course for your instructors to copy is fast and easy,
but you lose the ability to monitor each section. This option is the best choice for
administrators and coordinators that are only responsible for course set up and do
not have a need to monitor and analyze results from all sections.
In this scenario, you would create a standard course and set the copy settings to
―available to copy‖, set up the course and finalize your customizations and
organization, and then simply give each instructor the course ID to make a copy of
this course in their own instructor account. See Create/Copy Additional
Courses and Sections for instructions.

Navigation
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Accessing Your Course
When you have received the email indicating that your course is ready, you may
access your course.
• Go to www.mymislab.com.
• Click Sign In.
• Enter your login name and password.
• Click Sign In.
To enter your course, click on the course name listed in the MyLab/Mastering
New Design courses list.
You can review the course contents and add or delete materials to suit your needs.
The course becomes available for student enrollment on the date you set during
course creation.
Click Details to confirm that the dates you set for your course are correct and to
update course information. You can change the course start and end dates, as well
as the enrollment start and end dates, at any time.
Note: Your course has a max expiration date that is 24 months after the creation
date. The end date you set cannot be later than this expiration date. At the end of
a 3-month retirement phase that follows the expiration date, you receive emails
alerting you that your course is flagged for deletion.

Registration

Enable Students to Access your Course

Course Set-up

Warning: If you have chosen an integrated set up with your local LMS, please
follow those specific instructions to enable students to access your course. These
instructions will not apply.
To allow students access to your course:
1. Give students the course ID when the course or section is ready.

Gradebook
Course Mgmt.
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Best Practice: Show the FDOC
materials during class time to
ensure that students follow all
necessary steps to successfully
register and enroll in your
course. This will also help to
reduce the amount of questions
you receive from students
regarding registration!

Visit www.mymislab.com

Assignments

Registration

2. Provide students with the Student Registration Handout that was included in
your course creation confirmation email or printed from the Details link in
the courses list. And, refer students to the Pearson Students Facebook
page to access Getting Started materials:
 Get Going: Youtube Playlist tutorial Videos
 Get Assured: Students Speaks-Success Stories
 Get Help: 24/7 Technical Support

Navigation

Note: Students must enter the course ID when they register and enroll in
your course. Course IDs are typically formatted with your last name followed
by 5 digits (i.e. smith12345). They are also case sensitive and must be
entered exactly as they appear on your courses list.

How Students Register
Warning: If you have chosen an integrated set up with your local
LMS, please follow those specific instructions for student
registration. These instructions will not apply.
The student registration process is similar to instructor registration,
except that students must provide the course ID and purchase
access. From www.MyMISLab.com, students can register and
sign in, as well as find tours to get started and other support resources.
In addition to the FDOC materials referenced above, registration instructions also
appear in the Student Access Kits that students receive when they purchase a new
textbook package or the access kit independently in the bookstore.
Temporary Access Option
For some courses, students can access the full set of features in your course
without payment for 17 days. The Temporary Access option enables students
waiting for financial aid to start coursework and avoid missing deadlines you set.
Students will receive alerts via email indicating how much time is left until the
temporary access expires. Students can change temporary access to fully active
status at any time by entering purchase information. Click here for more
information about temporary access.

Registration

Edit Course Details
After you have created a course, you might find that you need to edit some aspect
of your course later in the term. You can easily do things such as:

Course Set-up








Rename your course
Add/delete/or edit the course description
Change the course type (For Student Enrollment or Instructor Use Only)
Edit the course enrollment start and/or end dates
Edit the course start and/or end dates
Change the copy settings (available or unavailable to copy)

Navigation

To edit course settings:
From the MyLab/Mastering New Design courses list:






Click the Course
Settings link in the
upper left of the course
and choose Course
Roster from the
dropdown.
On the Course Roster
page, click Settings on
the top left.
Make any edits and click
Save.

Course Mgmt.
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Gradebook

From inside your course:

Assignments



Registration



Click the Details link next
to the right of the course
name.
On the Course Details
page, click Edit Course.
Make any edits and click
Save.

Delete a Course
You can delete any course that you created as an instructor. Keep in mind that
you have two options to remove a course from your MyLab/Mastering New
Design courses list: permanently delete or hide from course display.
Best Practice: If you created a course by mistake, ―practice course‖ or duplicate
that you no longer need, deleting the course is the recommended action. However,
if you just want to clean up your courses list to remove older courses from view,
hiding the course from the Account Homepage is recommended.
To delete a course:
From the MyLab/Mastering New Design courses list:




Click the Details link next to
the right of the course name
On the Course Details page,
click Delete Course.
When the confirmation
dialog appears, click Delete
to permanently delete your
course, or click Cancel.

To hide a course from your display:
From the MyLab/Mastering New Design courses list:



Click the Settings link above your courses list
Uncheck the ―Show‖ box next to courses you wish to hide

Registration

Where do I go from here?

Course Set-up

Navigating the Course Menu
The Course menu appears on the left side of the Course window, making the tasks
you perform regularly more accessible. Use the Modify button above the Course
Menu to add, rearrange, style, and hide menu items in your course menu.

Gradebook
Student Experience

Note: Your Pearson eText is also available on the iPad. Click here for more
information and link to the iPad App.
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Course Menu buttons include:
 Course Home opens the Course Home page, where you can view your class
announcements and link to upcoming assignments. See Course Home for
more information.
o Purchase Options: Provides students with the purchase links needed
to obtain a print upgrade of the text or eText upgrade (if applicable).
o About this course: Gives a brief description of course content.
o Syllabus: Allows you to upload an existing syllabus from Microsoft®
Word® format or add syllabus items manually. See Creating Your
Syllabus for more information.
 Assignment Calendar helps you and your students keep track of when
assignments are due and when assessments are available. Users can choose
to see assignments organized in a List, Month, or Term view. See
Assignment Calendar for more information.
 Gradebook shows students their results on assigned work as well as their
overall score. They can also review assignments from this page. See
Gradebook for more information.
 Submissions houses uploaded files from student submission assignments.
You can review the submission and comment back to the student directly.
See Submissions for more information.
 eText allows you to search, highlight, and take notes that you can view
privately or share with students. Students who purchase MyLab access
including eText will also be able to search, highlight, take notes, and read
your instructor notes (if applicable) as they read online. Click here to learn
how to use the eText Notes Manager.

Navigation

Use the arrow icons
to expand to full screen or collapse for easier
viewing. The course settings link below the course title allows you to manage
your course roster and course files.














Chapter Content is organized by chapter folders. Each chapter contains
activities and assignments. See Assignments for more information.
Dynamic Study Modules work by continuously assessing student
performance and activity, then using data and analytics to provide
personalized content in real-time to reinforce concepts that target each
student’s particular strengths and weaknesses. See Dynamic Study
Modules for more information.
Communication Tools (see Communication Tools for more details):
o Email: Allows you to email the whole class or individual students.
Students can also email you and their classmates from within
MyMISLab.
o Document Sharing: Enables you to share documents by uploading
and creating categories to store them. Instructors and/or students can
then browse your categories to download the documents.
o Chat & ClassLive
 Chat: Creates and hosts web-based chat sessions.
 ClassLive: Allows students to join a session in real time. You
can show files and presentations and even allow students to
write in the file synchronously.
o Discussion: Groups all class discussions in one place.
Writing Space houses the auto-graded writing
assignments and the create your own assisted
grading writing assignments. See section on the
Writing Space for more information.
SharePoint provides you and your students
access to Microsoft SharePoint® — the industry
leading collaboration software. Each chapter in
your course contains a collaboration exercise
specifically designed to be assigned to student
groups to complete using Microsoft SharePoint or
another collaboration tool. See SharePoint for
more information.
Office 2010 Assignments: MyITLab links to
the market-leading MyITLab to give you and your
students access to Excel and Access training ,
assessment, and automatically scored Excel and
Access projects via MyITLab Grader. See Office
2010 Assignments: MyITLab for more
information.
Instructor Tools: Download the instructor
resources available for your text and review the
Video Lecture library with additional resources.
o Business Today
o Course Roster

Registration

Course Home

Course Set-up

Course Home is the entry point for your course. This page includes a
customizable course introduction area, announcements, social feed, assignment
notifications, gradebook notifications, and course scheduler.
Note: You can rename the Course Home and move any other menu item to the top
of your course menu to make that menu item your course entry point.

Gradebook

To access the Course Home Manager:
1. Click on Course Home from the course menu
2. Click modify and select Manage from the dropdown located at the top right
of the page.

Assignments

Using the Course Home Manager
You can create Announcements and customize your Course
Introduction using the Course Home Manager.

Registration

Activity Hub
Three categories are accessible through the Activity Hub:
 Activity: This feed acts as the course ―wall‖ and can be used by you and
students for discussion posts and remarks. It displays posts in real time and
all posts are viewable by everyone in the course.
 People: This tab within the Social feed allows you to see which users are
logged into the MyLab at any given time.

Navigation

Course Home with Activity Hub
With the enhanced Course Home, you can also view course activity, keep in touch
with the people in your course, view upcoming due dates, and view
submissions for review.

Student Experience
Course Mgmt.
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Announcements
You can create your own course announcements to welcome students to your
course, inform students about new content and assignments, remind students of
upcoming tests, post information about course-related resources, and more. You
can also include links to other content or menu items within an announcement.
Note: Announcements are categorized as Unread and Read. Once you have
opened an announcement, it will move from Unread to Read. You can re-access
any read items by clicking the Read button under Announcements.
To create a new course announcement:
1. Click Add Announcement at the top left of the Course Home Manager.
2. Type a brief title in the Subject text box.
3. In the content
editor, type your
announcement, format
the text, and add
content.
4. Select the Start and
End Display Dates
for your
announcement by
typing the date in the
text box or clicking
the calendar date.
5. Click Add
Announcement to
post your
announcement.
Or
Click Cancel to quit without saving your announcement and
return to Course Home Manager.
The announcement will appear as unread at the top of the announcements from
the Course Home page during the display dates you indicated.
Tip: If you want the announcement to remain visible for the remainder of the
course, you can use the course end date as the end display date.

Registration

Customizing the Course Introduction
You can customize the Course Introduction area of the Course Home page by
adding your own text and images.

Course Set-up

To customize the Course Introduction:
1. Delete the current image within the Visual Editor.
2. Use the Visual Editor or the Plain Text Editor to add your own image(s)
and text. (You can insert images already uploaded to a course folder or browse
to upload a new image.)
3. Click Save Changes.

Navigation

Note: Make sure to save changes before toggling from the Visual Editor to Plain
Text Editor.
Your custom Course Introduction will appear on the top of the Course Home Page.
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Creating Your Syllabus
Add your course syllabus so that it is easily accessible by students anytime. You
can upload an existing syllabus in Microsoft Word format or you can compose a
syllabus using the Visual Editor tool.
Note: You cannot combine both methods of creating a syllabus. If you import
your syllabus in Word format and then try to add syllabus items using the Visual
Editor, your Word document will be deleted. Likewise, if you create syllabus items
using the Visual Editor and then import a Word version of your syllabus, the
composed syllabus will be deleted.
To create a syllabus:
1. Click Syllabus on
the course menu.
2. Click modify and
select Manage from
the dropdown
located at the top
right of the page.

If you wish to add a syllabus in Word format:
1. Select Upload Microsoft Word Syllabus (.doc).
2. Click Add.
3. Click Choose File to select your Word document.
4. Click Upload & Convert File.
Your Word document will be uploaded in HTML format.
If you wish to compose your syllabus using the Visual Editor tool:
1. Select Compose Text Item (Visual Editor).
2. Type in the Title for the syllabus item you are adding.
3. Use the content editor to add and format each syllabus item.
4. Click Add Item or Cancel to discard your changes.
5. Repeat these steps for each syllabus item you want to add.
You can later edit, reorder or delete items in your syllabus by selecting them
in the Syllabus Items list.
Click Syllabus from the Course Menu to view the syllabus at any time.

Registration

Communication Tools
We have provided you with additional tools to make communicating and sharing
materials with your students easier.

Course Set-up






Email
Document Sharing
Chat & ClassLive
Discussion

Navigation

Email
Use the internal email feature to message your students directly within MyMISLab.
You can choose to send a message to one, some, or all students and include
attachments if desired.

Registration

Note: Make sure that you create categories before uploading documents as you
will not be able to transfer documents from one category to another after the
upload is complete.

Gradebook

To add new categories:
1. Click on Add Category.
2. Enter the Category Title.
3. Select an option in the Assign Category to drop-down menu.
4. Click Add Category or Save and Add Another Category to
add more categories.

Course Mgmt.
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Note: You will have the option to hide material from your students when you
upload it.
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Document Sharing
You and your students can share documents by uploading them with Document
Sharing. Your students will be able to download the documents you have uploaded
and upload their own documents. You can organize the documents you and your
students share by setting up categories to store the uploaded documents.

To upload a document:
1. Under Categories, select the category to contain the uploaded document.
2. Click Upload Document.
3. Under Share file with, select Instructor Only to hide the uploaded
document from your students or select Entire Class to share the document
with your students.
4. Click Choose File, select the file to be uploaded, and click Open.
5. If the selected file is a zip file and you want it unzipped as part of the
upload process, select Unzip .ZIP file.
6. Enter a description and click Add Entry.
To download a document:
1. Select the category containing the documents, then select the documents
you want to download.
2. Click Download Documents.

Registration

Chat

®

You can lead an Elluminate Live chatroom discussion with your students. You can
type messages to your students and they can type messages to you and to any
other students who join the chatroom.

Course Set-up
Assignments

To edit a chatroom:
1. Click the Edit icon in the Edit column.
2. Modify the chatroom information as necessary.
3. Click Save Changes or Cancel.

Registration

To view or delete a chatroom log:
1. Click the Chat Logs icon in the Chat Logs column.
2. Click a Session Date to view a log, then click back to return to the Chat
Logs list.
3. To delete a Chat Log, click the Delete icon in the Delete column, then
click Delete Room & Chat Logs or Cancel.

Navigation

To add a chatroom:
1. Under Course Tools, click Chat & ClassLive.
2. Click Chat.
3. Click Add Chat.
4. Type a chatroom Name in the text box.
5. Add a description and select other options as applicable.
6. Click Add Room to add your new menu item, or Cancel to discard your
changes. You can also click Save & Add Another Room to add more
chatrooms.

Gradebook

To join a chatroom:
1. Under Course Tools, click Chat & Class Live.
2. Click the chatroom name in the Chatrooms list.
You have now joined the chatroom.

Student Experience
Course Mgmt.

Join us! www.mybschoolcommunity.com

Experience

Visit www.mymislab.com

ClassLive
ClassLive is an interactive chat tool that allows you to communicate with your
students in real time. Place or draw objects on the whiteboard, share a software
application from your computer, participate in synchronous chat sessions with your
students, and work through complex problems one step at a time. ClassLive can
be used with a group of students or one on one.
The ClassLive tool is enabled by default. You can turn ClassLive on or off from
the modify page.
Note: The audio feature is not available in this version of ClassLive.
Keys for Success: We recommend you join ClassLive 5-10 minutes prior to the
start of your session to set your connection speed and ensure the session is up
and running for your students.
To create and lead a ClassLive session:
1. Under Course Tools, click Chat & ClassLive.
2. Click ClassLive.
3. Click Lead Session. (Students will click Join Session)
You will be asked to run the Elluminate Live! software. Once the
software is launched, read and accept the license agreement and then select your
connection speed.
You can use the Participant window, on the top left, to monitor participants and
assign permissions for live activities. The Participants panel provides you with an
overview of what is happening within the session.
In the Chat window, your students will be able to share messages with you and
other participants.
• You can load presentations, such as PowerPoint slides, by clicking the folder
icon in the lower left corner of the Whiteboard toolbar.
• Select the Help menu in the Elluminate Live! window for further assistance.
• To end the session, select File > Exit, or close the Elluminate Live! window.
Note: As a stand-alone tool, ClassLive includes a training page with video
tutorials and additional documentation provided by Elluminate, Inc.

Registration

Discussion

Course Set-up

Discussions allow your students to share ideas with you and each other. You can
create your own discussion topics and/or utilize the pre-loaded discussions set up
in chapter folders under the Discussion tab in your course menu. Your students
can respond to the topic as well as each other’s posts from within each discussion
topic. Discussions can also be referred to as threaded discussions since your
students’ lively responses form an intertwined thread.

Assignments

Registration

To add a discussion topic:
1. Click the Discussion menu item (the content pane will
display added discussion topics).
2. In the upper right hand corner, click modify > Manage.
3. The Discussion Manager will open. Click Add Topic.
4. For Title, add the subject of your topic.
5. Use the content editor to describe the topic or pose
questions to your students.
6. OPTIONAL: Attach files to your topic.
7. Click Add Topic.

Navigation

Note: Unlike the Live Chat and ClassLive online classroom, discussions are
asynchronous. Students do not have to participate at the same time; instead, they
add threads to the discussion at a time that works for them.

Gradebook
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To manage your discussions, you can sort and filter responses, and mark them as
unread.
To sort responses, click any column header in a discussion thread to sort
responses according to that label (i.e. click Author to sort the responses
alphabetically by the students’ names).
To filter responses:
1. Click Show Options in a discussion thread to display additional fields.
2. Next to Select, choose to select All, None, Unread, Read, or Inverse
from the options dropdown.
Note: Inverse clears selected responses and checks unselected responses.
3. Click View Selected to only view those responses that match your
selection.
To mark a response as unread/read:
1. Click the open envelope icon. To later mark the response as read, click
the closed envelope icon.
OR
2. Click Show Options > choose Select All, None, Unread, Read, or
Inverse> Choose Unread in the Mark selected as dropdown. To later
mark the response as read, repeat the same steps and choose Read in the
Mark selected as dropdown.

Registration

Business Today

Course Set-up

Business Today houses up-to-date videos and activities that you
can use immediately in the classroom. This includes videos with
discussion questions and videos, author blogs, recommended
author exercises for the book you're using and more.

Navigation

Business Today is an instructor only resource found in the course
under Instructor Tools and is hidden by default. In order for
students to view the videos and other material found in Business Today, you will
need to copy and paste the links into a new menu item for students. See Add a
Menu Item for instructions to add the item to your course menu.
How to link to a video URL or other website from a content page:
1. In a content page, click modify > Manage above the content pane. (The content
editor displays with a series of command icons at the top)

4. For Text to display, type a link name.

Registration

3. On the Add a Link page, select Link to a Website, and click Continue.

Assignments

2. Place your cursor where you want to add the link and click the Add a Link icon.

5. For Website address, paste the URL of the video or type the URL of the website.
Gradebook

6. Click Add Link.
7. Click Save Changes and modify > View above the content pane.
*When your students click the link, a browser displays the video or website you
linked to.
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Design Your Course
You can customize your course to give your students an effective learning
experience. Update your course menu, hide items, add new items, and add your
own content, including Microsoft® Office files, Adobe® PDFs, images, and videos.
Use the course features and tools to create a comprehensive and engaging
learning experience for your students.

Modify Your Course Menu
To modify and manage your course menu, you’ll need to access
the Modify Lightbox feature. By clicking Modify above the
Course Menu, you’ll be able to access the following Lightbox tabs:
 Settings
 Add & Arrange
 Restore
 Style
Once open, you can resize the lightbox. The square icon in the upper right corner
of the lightbox increases the size of the lightbox window. This allows you to see
more items in the lightbox when you have a long course menu.

Registration

Settings Tab
The Settings tab allows you to edit an item name, hide an item, mark an item as
gradable, and mark an item as a submission.

Course Set-up

Edit item name: You can edit an item name either on the Settings tab or the Add
& Arrange tab.
1. Hover your mouse over the item name.
2. Click on the name. An edit icon ( ) and a text box appears.
3. Type the new name.
4. Press Enter.

Navigation

Hide item: Items can be hidden from student view. Any items that you want to
remain in the course menu, but not have students see or access, should be
hidden.
1. In the hidden column, click the check box for to the item you want to
hide.
2. The item is now hidden from student view.

Assignments

Registration
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Mark item as gradable: You can use the lightbox to mark items as gradable.
This will create a column in the gradebook for this item.
1. In the gradable column, click the check box for to the item you want to
to make gradable.
2. The item will now appear in the gradebook.
Note: Be sure to assign a point value to the item. View the Gradebook section
for important gradebook recommendations.
Keys for Success: Only Mark Items You Want to Appear in the Gradebook
as Gradable
Your MyLab will not currently prevent you from marking any tool or item as
gradable—including the gradebook, itself. Be sure that the items you select as
gradable are items you want to appear as columns in the gradebook.
Mark item as submission: You can use the lightbox to mark items as a
submission. This will create a "dropbox basket" in the Submissions tool (once the
Submissions Menu item has been restored).
1. In the submission column, click the check box for to the item you want
to make a submission.
2. The item will now appear in the Submission tool.
Note: In most instances, a submission item will also be "gradable,‖ so you’ll
also want to check the Gradable box and assign a point value to the Submission
item. View the Submissions section for more information and instructions to
restore the Submissions Menu item.
Keys for Success: Only
Mark Items You Want to
Appear in the
Submissions Tool as a
Submission
Your MyLab will not
currently prevent you from
marking any tool or item as
a submission. Be sure that
the items you select as
submissions are items you
want to appear as "dropbox
baskets" in the submissions
tool.

Registration

Add & Arrange Tab







Assignments



Registration



Navigation



Content Page: Creates a content page for you to edit. Once added,
click modify > Manage above the content pane to add text or images in
the content editor.
Threaded Discussion: Creates a discussion where you add topics for your
students to respond to.
Uploaded Content: Lets you upload an Adobe PDF file, Microsoft Office file,
HTML file, video, or image, and associate it with the new menu item. After
creating the menu item, navigate to it and click modify > Upload
MS Office File or modify > Upload Content (PDF, HTML, etc.) above the
content pane.
Gradebook-only Item: Adds an item to the gradebook. The item does not
appear in the course menu. For example, you may want to add a Class
Participation, or Attendance score.
Assessment: Creates an assessment item in the course menu. Once added,
click the new assessment item in the course menu, and click modify >
Manage above the content pane to add questions and configure questions
and exams.
Linked Content: Creates a menu item that links to an external website.

Course Set-up

The Add & Arrange tab allows you to add new items, edit item name, order
items, and archive items you no longer wish to have in the Course Menu.
Adding new items to your course is a great way to incorporate your own
instructional material and assignments. A drop-down list of item types appears
when you choose to add an item to your course. You can add the following:
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Add new item
You can add a new main-level item to the bottom of the course menu, or add a
―child‖ item to an existing ―parent‖ item.
Add main-level item
1. Either click the Add new item button
or
scroll to the bottom of the item list on the Add & Arrange tab and click Add
new item to main level link.
2. Select the appropriate item type.
3. Input a menu item name.
4. Select appropriate item settings (e.g., hidden item, etc.).
5. Click the Save button. The item will appear at the bottom of the course
menu.
Add child item
1. Click the expand arrow ( ) to the left of the parent item to expand it.
2. A link will appear: add new item to [parent item name]. 3. Click the
link.
4. Select the appropriate item type.
5. Input a menu item name.
6. Select appropriate item settings (e.g., hidden item, etc.).
7. Click the Save button. The item will appear within the parent item in the
course menu.
Edit item name: You can edit an item name either in the Settings tab or the
Add & Arrange tab.
1. Hover your mouse over the item name.
2. Click on the name. An edit icon ( ) and a text box appears.
3. Type the new name.
4.
Press Enter.

Registration
Navigation
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Student Experience

Archive an item
You can archive an item to remove it from the course menu. Unlike hiding an item
from the students, archiving will completely remove the item, streamlining your
menu and removing items you do not feel you’ll use during the term. Or, if you’ve
added an item but wish to remove it, you must archive it in order remove it from
the menu.
1. In the archive column,
click the archive icon ( ) for
to the item you want to
remove from the course
menu.
2. Archiving an item won't
fully delete the item. It will
move it to the Restore tab,
where it can be restored back
to the course menu or fully
deleted.

Assignments

Child items can be added to parent items or otherwise ordered by clicking the
expand arrow ( ) of the parent item. This will dynamically change the numbering
in the text boxes and it will change the order in which the up/down arrows move
items.

Registration

1. In the order column,
use either the numbered
text boxes or the
up/down arrows to order
items.
2. The numbered text
boxes allow you to
quickly bump an item’s
order. For example, to
move an item in ninth
position to first position,
type the number "1" in
the text box.
3. The up/down arrows will move the item one position, either up or down.

Course Set-up

Order item
Whether it’s to list the most important items in your course at the top of the
course menu, or to rearrange content to better match your syllabus, you can
reorder the items in your course menu however you like. Use the ordering
feature’s up/down arrows or dynamic numbering to place items where you want
them.

Restore Tab
The Restore tab allows you to either restore an archived item to the course menu
or fully delete it from the course altogether.
Restore an item
1. In the restore column, click the restore icon ( ) to add a previously
archived item to the course menu.
2. The item will be restored to the bottom of the course menu. You can
reorder the item on the Add & Arrange tab.
Delete an item
1. In the delete column, click the delete icon ( ) to add a previously
archived item to the course menu.
2. The item will be fully deleted from your course and will not be retrievable.

Style tab
The Style tab allows you to change the default color of the banner and course
menu.

Registration

Assignments
Course Content

Course Set-up

Course Content houses all of the assignable content student study tools. There are
several different types of exercises, activities, and assessments that can be
utilized in your course. Some assignment types vary by book and discipline, so if
you see an assignment below that
does not appear in your course, it
may not be applicable.

Registration



Gradebook

To help you decide which assets
might be best suited for your
course, we have provided an
explanation and helpful
information for each item.
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1st Semester Instructor Tip
MyMISLab offers you a full arsenal of materials for your course, but can be
overwhelming in your first semester using the program. During your first
semester, we recommend only choosing 2-4 items per chapter to assign to
students and “hide” the rest. As you get more comfortable with the program, you
can add additional activities. The following activities are widely used and would
provide a great starting point:
 Video Exercises
 Simulation Exercises
 End of Chapter Collaboration Exercises
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Assignments



eText
Flashcards
Video Exercises
Simulation Exercises
Application Exercises
End of Chapter
Collaboration Exercises
End of Chapter Assistedgraded Writing Assignments
Test Bank Assignments

Navigation








eText
Your MyLab course includes a complete eText that allows you to search, highlight,
and take private notes or notes that you can share with students. Students who
purchase MyLab access
including the eText will also
have the ability to search,
highlight, take notes, and
read your instructor notes (if
applicable) as they read
online. Click here to learn
how to use the Notes
Manager in your eText to
share notes with your
students.
Your Pearson eText is also
available on the iPad. Click
here for more information
and link to the iPad App.
Flashcards
Interactive Flashcards are one of the student resources offered in your course.
They allow students to practice terms and definitions from the course. The activity
also offers a self-quizzing feature where the student can choose a multiple choice
quiz answering by term or by definition and speed drill option. Flashcards are a
non-graded activity used for remediation.
Note: Students also have the option to export flashcards to their mobile phone if
desired.
Video Exercises
Engage your students with the robust
selection of videos that help students see
concepts in action. The videos are
customized to match the text objectives
and are presented in a condensed format
so you can show them in class or
assign them as homework.
The Video Cases are located within
the chapter material. These activities
are discussion based and can be
assigned for participation and
contribution grades.

Registration
Course Set-up

Simulation Exercises
Are you looking for a way to engage your students with an activity that allows
them practice applicable business skills and learn from mistakes? Unique minisimulations use adaptive technology to allow students to see the impact of the
business decisions they make. These simulations place students in the role of
decision maker and pose questions in real-world scenarios.
Note: Not all MyMISLab courses contain simulations. Please check with your
Pearson Sales representative to confirm simulations for your textbook.

Gradebook

End of Chapter Assisted-graded Writing Assignments
Assign writing prompts and have students draft and complete essay responses
right here in your course. Assisted-graded writing assignments consist of writing
questions from the book’s end of chapter materials or cover key learning
objectives. Each assignment contains a clickable grading rubric to assist you as
you review student responses. Your course also contains Auto-graded Writing
Assignments that can be assigned to students. See Auto-graded Writing
Assignments for more information.
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Test Bank Assignments
Each chapter includes Test Bank Assignments in the Chapter Menu item that can
be edited or randomized and assigned. Assignments using test bank questions
from each chapter offer a great way to assess your students’ knowledge of chapter
terms and concepts. Test Bank Chapter folders contain both an option for an
objective-based activity as well as an essay based activity. See How to Assign
Test Bank Assignments for more information.
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Registration

End of Chapter Collaboration Exercises
End of Chapter Collaboration Exercises are focused on topics pertaining to
decision-making, problem solving, and project management. These exercises are
specifically designed to be assigned to student groups to complete using Microsoft
SharePoint® or another collaboration tool.

Navigation

Application Exercises
Application Exercises challenge students to solve real-world management
problems using Access and Excel. For each application exercise, MyMISLab
provides students with access to corresponding training simulations from the
market-leading MyITLab product, so students can brush up on their Excel and
Access skills.

Dynamic Study Modules
Based on brain science research, Dynamic Study Modules
customize the learning experience for each student to maximize
study efficiency and improve long-term retention of material.
When students first click on a Dynamic Study Module, they are shown a short set
of multiple-choice questions. For each question, they can choose:
1. One answer, by
dragging and
dropping it to "I
am sure." The
program will
respond that
the answer is
correct or
incorrect.
2. Two answers,
by dragging and
dropping them
to "I am
partially sure." The program will respond that both, one, or none of the
answers are correct.
3. No answers, by clicking on "I don't know."
At the end of each module, students can review answers and explanations to all
questions in that module.
After reviewing this material, students can then move on to answer more
questions in a new module. The new set of questions emphasizes material that
student previously got incorrect. Students keep answering questions until they
master the material by getting questions for each learning objective confidently
correct twice, at which point the module is considered complete.
Note: Dynamic Study Modules are for student self-study and can only be accessed
from within a course you have created for your students or by mobile device.
To access to Dynamic Study Modules in the course:
1. Click the Dynamic Study Modules menu item in the course navigation
2. Click the Access Dynamic Study Modules button in the right frame.
3. When the Dynamic Study Modules window loads, students can select which
module they wish access for learning, review or refresher.
Note: If Dynamic Study Modules are not yet available for your textbook, you will
not see a Dynamic Study Module menu item in your course.

Registration

To access to Dynamic Study Modules on a mobile device:

Course Set-up

After students have accessed at least one Dynamic Study Module from within their
MyLab course, they also can study using these modules on a mobile device. To
access the modules on a mobile device, they first must download the Dynamic
Study Module app from the App Store or Google Play. A student then can sign in
using their MyLab username and password to access the Dynamic Study Modules
from their device.
All of the student’s study work is synced between the student’s computer and
mobile devices -- and those results appear in your instructor reports.

Navigation

The Dynamic Study Modules app works on most Android smartphones and iPhone
and iPod Touch devices. For more information, see Downloading the Dynamic
Study Module app.
Note: As an instructor, you can complete the same steps to experience the
Dynamic Study Modules from the student perspective.

Gradebook

You can, however, view and download a number of reports that show your
students’ progress, completion, and average time spent using Dynamic Study
Modules.

Student Experience

To access the Dynamic Study Modules Reports:
1. Expand the Dynamic Study Modules menu item in the course menu.
2. Click the Dynamic Study Modules Results menu item.
3. Click the Dynamic Study Modules Results button.
Note: If a student has not yet accessed any of the Dynamic Study Modules, they
will not appear in any reports nor will they be included in overall student counts.
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Dynamic Study Modules Reporting
Dynamic Study Modules are designed for learning, not
assessment, and thus currently cannot be assigned for credit.
Completion status and grades also do not currently report to the
Gradebook, although this feature will be available in a future
release of your MyLab.

To generate a report for Dynamic Study Modules:
1. In the Create My Report window, select a report to generate.
2. Depending on the report you chose, select the students or the specific
module on which to report.
3. Select the date range the report should cover.
4. If you want to generate a .csv file, select the CSV Report check box. If you

don’t select this box, the report will be generated as a PDF.
5. Click Run Report.
6. If you generated a CSV report, click Cancel/Close to dismiss the
informational message and then open the CSV file from your downloads.
7. If you generated a PDF report, click the My Reports tab and click View PDF
for the report you want to display.
Note: PDF reports remain available from the My Reports tab for 30 days. If you
want to keep a PDF report for later reference, view the report and use your
browser's Save feature to save it to your computer.
Note: Only 25 reports display in the My Reports tab, by default. If you have
generated more than 25 PDF reports within the past 30 days, you can select All
above the Report column to list all of them on the My Reports tab.

Registration

Course Aggregate Reports
These reports provide the following summary data for one or more of your courses
using Dynamic Study Modules:
Progress by Module: This report demonstrates which of the assigned
modules are completed and which are still in progress for the selected
course(s).

Course Set-up



You can reference this data to quickly ascertain which assigned modules
their students have completed before they enter the classroom, so you can
tailor their lecture to correspond to student knowledge needs.
Initial Knowledge by Module: This report shows the average initial
knowledge for each assigned module for the selected course(s). Initial
knowledge refers to the accuracy with which students were able to answer
questions the first time they were presented.

Gradebook

Module Progress by Student : This report shows module progress for all
the students in the selected course(s) – detailing the number of modules
completed, the number of modules in progress, the average difficulty of the
completed modules and the total time spent on a learner-by-learner basis.

Assignments



Registration

Identifying Initial Knowledge allows you to easily pinpoint what students
already know, what they still need to learn, what concepts need
reinforcement and where they need the most additional study and
instruction. From here, you are empowered to support students in
addressing topics that need the most review and they’re enabled to move
beyond materials that the class has already mastered.

Navigation



This report allows you to quickly identify what individual students have
studied within their learning program or course, proactively address student
challenges and knowledge needs and reward excellence.
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Individual Student Reports
These reports provide summary data for an individual student:


Student Initial Knowledge by Completed Module: This report shows an
individual student’s initial knowledge across each completed module. Initial
knowledge refers to the accuracy with which an individual student was able
to answer questions the first time they were presented.
You can easily pinpoint what each student already knows, what he/she still
needs to learn, what concepts need reinforcement and where he/she needs
additional study and instruction. This detailed leaner-by-student data
informs coaching and mentoring programs and allows you to identify where
individual leaners are struggling or excelling in each assigned module.



Student Progress by Module: This report measures an individual
students’ progress within each module, including: how much of each module
he/she has completed, how difficult each completed module was for him/her
and the total time he/she spent completing each module.
This report can be used to help you evaluate student participation, quickly
determining student progress, if a student is at-risk and which modules are
most challenging for a particular student.



Weekly Module Completion Report: Created once a week, this report
provides module completion details for all the students enrolled in the
selected course(s), including for each student: name of the completed
module(s), completion date, average difficulty and time spent.
This report allows you to quickly assess student participation and homework
completion, identify modules where students are struggling and map student
performance to time spent studying in Dynamic Study Modules.




Registration



Course Set-up

Module Progress by Student: This report shows how much of each
chapter has been completed across each student enrolled in the selected
course(s) – detailing the number of questions answered, the percentage
complete, the average difficulty and total study time on a student-bystudent basis.
This report allows you to quickly identify the modules individual students
have completed from a particular chapter, and proactively address student
participation.

Navigation
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To generate a report for Dynamic Study Modules:
8. In the Create My Report window, select a report to generate.
9. Depending on the report you chose, select the students or the specific
module on which to report.
10.
Select the date range the report should cover.
11.
If you want to generate a .csv file, select the CSV Report check box. If
you don’t select this box, the report will be generated as a PDF.
12.
Click Run Report.
13.
If you generated a CSV report, click Cancel/Close to dismiss the
informational message and then open the CSV file from your downloads.
14.
If you generated a PDF report, click the My Reports tab and click View
PDF for the report you want to display.

Student Experience

Note: PDF reports remain available from the My Reports tab for 30 days. If you
want to keep a PDF report for later reference, view the report and use your
browser's Save feature to save it to your computer.
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Note: Only 25 reports display in the My Reports tab, by default. If you have
generated more than 25 PDF reports within the past 30 days, you can select All
above the Report column to list all of them on the My Reports tab.
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Note: if a student has not yet accessed any of the Dynamic Study Modules, they
will not appear in any reports nor will they be included in overall student counts.

Microsoft SharePoint Portal Access
Access to Microsoft SharePoint® — the industry leading
collaboration software — is included for both you and your
students as part of your Pearson MyMISLab experience. Each
chapter in your course contains a collaboration exercise
focused on topics pertaining to decision-making, problem
solving, and project management. These exercises are specifically designed for
student groups to complete using Microsoft SharePoint or another collaboration
tool.

Before your students can access the Microsoft SharePoint portal, you will need to
set up your course-specific portal.
To set up the Microsoft SharePoint portal for your course:
1. Locate the SharePoint parent menu item in your course and then click the
How to Add Sharepoint menu item.
2. Click the link to contact your Pearson Representative.
3. Complete the steps in the Pearson rep locator to identify and email your
Pearson Sales Representative to request help setting up SharePoint in your
course.
4. Your Pearson Sales Representative will work with you to collect information
from you in order to create a SharePoint site collection for your school.
5. Once the site collection is set up, you will receive a package, including a URL
and administrator access information. You also will receive a Getting Started
Guide to show you how to set up your specific class sites and add student
users.

Registration

After you have set up your Microsoft SharePoint portal following the instructions in
the Getting Started Guide, share your course’s SharePoint access information. Be
sure to give them all of the required information, including their SharePoint
usernames and passwords.

Course Set-up

Unhiding the Microsoft SharePoint portal in your course:
Before students can access the Microsoft SharePoint portal, you need to ―Unhide‖
the hidden SharePoint menu item in your course. To do this:

Navigation

1. Click the Modify link above the Course Menu.
2. Click on the Settings Tab, find the SharePoint Menu item and uncheck the
"hidden" column.
After you have set up and unhidden the Microsoft SharePoint portal in your course,
your students can use this to complete the Collaboration Exercises located in
Course Content for each chapter. For more instructions, see Using Collaboration
Exercises in your Course.
Registration

Your MyMISLab course includes Collaboration Exercises that help assess your
student’s understanding of key learning objectives covered in each chapter and
encourage group work and collaboration. These exercises are specifically designed
for use with Microsoft SharePoint® or other collaboration tool, such as Google
Drive, Google+, Windows Live SkyDrive, or Office 365.

Assignments

Using Collaboration Exercises with Microsoft SharePoint:

Gradebook

Collaboration Exercises are located in Course Content for each chapter. Each
chapter has one End of Chapter Collaboration Exercise. To schedule Collaboration
Exercises and add them to the assignment calendar, add a Due Date Alert via the
Assignment Calendar on the date for which the assignment is due. For more
instructions, see Adding due date alerts using the Assignment Calendar.

Student Experience
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Each assignment provides a series of questions to be answered by a group of
students. The assignments are structured so that students complete the
assignment using only email and a collaboration tool to conduct meetings and
organize their group response.
Students submit their completed Collaboration Exercises via Submissions. To do
this, a student will:
1. Click Submissions located in the left navigation.
2. Select the appropriate exercise from the Assignment dropdown menu on the
right.

3. Attach the assignment file, add any additional comments, and then click
Submit Assignment. Remind students to include their name and assignment
information in the file name (for example,
jsmith_ch1_collaborationexercise.doc).
For more instructions on using and reviewing Submissions, see Submission
Assignment.
MyITLab
MyMISLab is integrated with the market-leading MyITLab to give instructors and
students access to Excel and Access 2010 trainings and assessments. There is also
access to MyITLab Grader, which allows for automatically scored Excel and Access
projects.

Registration
Course Set-up

Application Exercises & MyITLab Training
Your MyMISLab course includes two Excel- and Access-based
application exercises, which mirror your textbook content. These
exercises ask students to solve situations using a spreadsheet or
database application. Each exercise links to the data sets needed
to complete the assignments, as well as the eText pages from
the book outlining the assignment. The completed files can be submitted through
MyMISLab. For each application exercise, MyMISLab provides students with access
to corresponding training simulations from the market-leading MyITLab product.
These training simulations give students an opportunity to brush up on the Excel
and Access skills needed to the complete the Application Exercises.

Navigation

To complete MyITLab training exercises:
1. Click the Application Exercises menu item in the Chapter Content >
Chapter folder for the desired chapter.
2. Click the Application Exercise menu item.
3. Click the Training for Microsoft Excel [MyITLab] or Training for
Microsoft Access [MyITLab] item.

Assignments

Registration

Gradebook
Student Experience

4. Click the Application Exercises: Training for Microsoft Excel and
Access folder in the right frame.
5. Click either the Microsoft Excel or Microsoft Access training folder.
6. Locate the training that corresponds to the chapter Application Exercise.
7. Click the link to launch and complete the MyITLab training.
Students also can access these training exercises outside of the Application
Exercises by clicking the Office 2010 Assignments: MyITLab menu item and
then clicking Office 2010 Assignments and then completing the previous steps.

Join us! www.mybschoolcommunity.com
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Note: Before starting the training exercises, students should review and complete
the materials in Getting Started with MyITLab to ensure their computer system is
ready to go.

Create New Assignment
Whether it’s to free up class time or give your students more opportunities to test
themselves on course concepts, you may want to administer additional homework,
quizzes or tests you have created already or by using the tools in MyMISLab.




Assign chapter tests or quizzes using the built-in test bank
Create your own custom assignments
Or Import tests, quizzes or exams from Respondus or TestGen .zip files.

Chapter Tests
Your course menu provides a Test Bank menu item under each
chapter menu item to house test bank questions for each chapter
(both objective-based and essay). The Objective-based activity will
be auto-graded, whereas the essay activity would require manual
review and scoring. You can review, edit, or randomize the questions
before setting the scheduling and configuration for the assessment.

Note: The Test Bank menu item (along with all of its contents) is hidden by
default. You will need to customize, assign, and unhide any items that you want
students to have access to in their course. See How to Assign Test Bank
Activities for more information.

Registration

Custom Assignments
To create an assignment, you must first add it as a menu item, then you will be
able to add the questions, schedule and configure it.

Navigation
Gradebook
Course Mgmt.
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Best Practice: If you’re not sure at this point what the value will be, you can wait
until later to specify. You’ll want the point value to be the same as the total point
value of the questions in the assessment. You can later update the point value of
the assessment by clicking Gradebook, modify > Setup, and updating Points.
5. Select the Hide from students check box ONLY if you do not want the
assessment to appear in your students' course menus.
Note: You can add an assessment before you’re ready for students to access
it by hiding it from students. Then you can go back to the Modify Course
Menu tool and unhide it later.
6. Click Save to add your new menu item, or Cancel to discard your changes.
7. Exit from Modify Course Menu.
8. Click the assessment item in the course menu, then click Manage
Assessment to develop or import your quiz or exam.

Assignments

Registration

1. Click Modify above
the course menu
and click the Add
and Arrange tab.
2. Click the Add new
item button or
expand the menu
item you want the
new item to reside
and click the Add
new item link.
3. For Menu Item
Type, select
Assessment.
3. For Menu Item
Name, enter the
assessment name that you want to appear in the course menu, such as
―Midterm.‖
4. Click the checkbox for Gradable so that student assessment results are
immediately calculated and entered into the gradebook when they complete
the assessment. For Points, enter the number of points you want to assign
this assessment in the gradebook (if the Gradable checkbox is not checked,
you can create the assessment, but grades will not be entered into the
gradebook).

Course Set-up

Add an Assessment menu item:

Add Questions
1. Click Add Section.
2. Enter a name for the new section.
3. OPTIONAL: If you’d like to randomly select a certain number of questions
from your section, check the ―Randomly select‖ check box.
 Enter the number of questions to be included in the question pool for
this section.
 Enter the number of points for each item in the question pool. Any
question in this pool will need to have the same point value.
4. Click Update Section.
To add a question:
1. Click the add icon ( ).
2. Enter the number of points assigned to the question. You can edit the
question later, if you want to change the number of points assigned.
Note: if your question is part of a pool of randomly selected questions, you
won’t be able to enter the number of points because you already gave it a
point value when creating your pool.
3. At the top of the question window (Add to ―X‖) select the type of question:
 True of False
 Multiple Choice
 Multiple Answer
 Fill-in-the-Blank
 Matching
 Short Answer
 Essay
4. Enter the Question Text
and specify the correct
answer or answers.
5. Click Add general
feedback to provide
information that
students see after
answering the question.
6. Click Add feedback to
provide information to students for each answer choice of true/false,
multiple choice, and multiple answer questions.
7. Click the check mark to the left of the correct answer for true/false, multiple
choice, and multiple answer questions.
8. Click Add Question.
Continue adding all of the questions and/or sections you need to finish your
assessment. Click Preview, then Begin Assessment to be able to experience taking
the assessment.

Registration

Import Tests/Exams from Respondus or TestGen

Course Set-up

If you have assessment files already created in other test generating programs,
MyMISLab allows you to import those existing questions. Then you can edit,
rearrange, and randomize any of the questions that you've added.

Navigation

You can import assessment packages created in TestGen or Respondus
applications.
 If using TestGen, be sure to use the Export > QTI (WebCT CE6, WebCT
VISTA) option. The import feature does not currently support native TestGen
formats, such as .bok or .tif.
 If using Respondus, be sure to use the IMS QTI 1.1+ personality for
exporting your assessment content.
The question types supported for import include true/false, multiple choice,
multiple answer, short answer, essay, fill-in-the-blank, and matching questions.

Registration

Best Practice: See this Knowledge Base article on how to assign point value in
TestGen before importing the file into your course.

Student Experience
Course Mgmt.

Join us! www.mybschoolcommunity.com

Experience

Visit www.mymislab.com

Gradebook

To import a TestGen assessment package into your course:
1. Create your test in the TestGen application.
2. From TestGen, choose File>Export and choose QTI (WebCT
CE6, WebCT VISTA) and save as .ZIP file to desired location.
3. From your MyLab course, click your Assessment menu item
in the course menu
Note: You must add an assessment menu item before importing an
assessment package for that assessment. See Add Assessment Menu
Item.
2. Click Modify > Import above the content pane.
3. Click Import.
4. For Choose Assignment Package Type, select one of the supported
assessment package types. (Supported assessment packages include
Respondus and TestGen)
5. For Select File, browse to select the .zip package to be imported.
6. Click Upload and Import File.
7. Click OK on the confirmation page.
8. You can import another assessment or click Status to monitor the progress
of the import.
9. Click Modify > Manage to edit or preview your Assessment.

Assignments

If you import assessment packages to an existing exam, the new questions are
added to the beginning of the exam. You can rearrange sections and questions.

Submission Assignment
The Submissions tool is offers an online ―dropbox‖ for communication between you
and your students for an assignnent where you require students to upload a file
(Word, PowerPoint, Excel, PDF, etc.) as a response.
The Application Exercises include in your MyMISLab are marked as this activity
type. After completing the assignment, students are instructed to upload their final
files via the Submissions tool. To review and/or score student submissions to
activities completed within the course, see Review and Score Student
Submissions.
How does a Submission Assignment work?
1. Students complete the assignment and upload their document to the
Submissions area.
2. You retrieve the assignment from your Submissions area, grade and
comment, then return it.
3. When needed, you can coach a student by providing multiple responses to
help clear areas of confusion. Submissions are especially useful if you'd like
students to submit multiple revisions of an assignment.
4. After you finish reviewing each student's submission, you enter the grade
in the Gradebook.

You can set up any assignment as a submission via the course menu.

Registration
Course Set-up
Navigation
Assignments
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To create a submission:
1. Click Modify above the course menu and click Add &
Arrange.
2. Click Add menu item or Add new item to main level
to add a new item to the main level of the course menu.
- To nest a new item within another level of the
course menu, click the expand icons and click Add
new item to… at the level you want.
3. For Select Item Type, select any item type.
- Any item type can be a submission.
4. Enter the Menu Item Name you want to appear in the course menu.
5. Click Allow Submissions if you want students to complete a submission
for you to review.
- If you don't
make an item a
submission when
you first create
it, you can make
it a submission at
any time. Click
modify above
the course menu,
click Settings,
and select the
submissions
check box for the
item.
6. Select the Hidden from Student check box if you do not want the
item to appear in your students' course menus.
- If you hide the item from students, there will be no menu item for
the submission, but students can click Submissions in the course
menu to submit the assignment.
7. Click Save to add your new menu item, or Cancel to discard your
changes.
8. Click Close.
9. Click the submission's menu item, and click Manage Assessment to
add the content for the submission.
- You can provide instructions for completing the assignment, as well
as links to uploaded files if they're needed for the assignment.
- You can also instruct students to click Submissions in their course
menu when they're ready to submit the assignment for you to review.
- If you want students to upload multiple files to complete an
assignment, you can include that in your instructions.

To review submissions:
1. Click Submissions. (All submitted assignments display. A count indicates
how many submissions are awaiting your review.)
2. To filter by a particular assignment, click Assignment and select the
submission you'd like to review.
3. For each student who has submitted the assignment, click an attached
file.
Note: Students can upload multiple files within a submission.
4. You can provide feedback directly in the assignment by saving and editing
the attached files.
5. After you review the assignment, click Comment & Return
Assignment.
6. In Comments, enter your feedback.
7. If you've edited a student's assignment to provide feedback, click Attach
a file and select the file.
- Click Attach another file to include additional files with your
feedback.
- Click Remove next to a file if you no longer want to include it with
your feedback.
8. Click Comment & Return Assignment.
Note: Once you have reviewed all submissions for an assignment, the
Submitted for Review list for that assignment is empty.
9. For gradable submissions, enter the student’s grade in the gradebook.
Note: Click No Submission to view the students without submissions for the
assignment or Returned to view the submissions you've already reviewed for the
assignment.

Registration
Course Set-up

Edit an Existing Assignment
You might decide that you want to use one of the activities or assignments loaded
into your MyLab course, but need to make changes like adding/deleting questions
or changing the point value. You can easily accomplish this by using the activities’
Assignment Manager and edit feature.
To edit an assignment, click the menu item of the assignment and click Manage
Assessment.
 Click the add icon in the main area to add a custom question to the
assignment
 Click the pencil icon in the main area to randomize the questions by pulling
only a set number of questions from the entire question pool at random

Navigation
Gradebook



Student Experience

Edit the point value of an Assignment
See Gradebook Setup for instructions.
Reset or Add Additional Time on an Assignment
See Reset an Assessment and Add Additional Time for instructions.
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Click the pencil icon next to
each question to edit the
question, answer, feedback or
point value for each question
Click the ―x‖ icon to remove
the question from the
assignment
Click the up/down arrows to
move the order of each
question

Registration



Assigning Activities (Setting Due Dates and
Parameters)
You can set due date alerts for ALL assignable items in the course by using the
assignment calendar. In addition to this method, depending on the activity type—
there are different ways to schedule/assign hard due dates in your course.
Assignment Calendar
Assigning due dates using this calendar feature will add these dates
to the student view calendar as well as the Upcoming Assignments
area on the Course Home page. However, it will not prevent the
student from submitting an assignment past this date. It merely
acts as an alert to students of when the item is due. See additional
scheduling options for each activity type to learn about setting hard
due dates and other preferences.
Best Practice: Use the Assignment Calendar in conjunction with other scheduling
options for activity types that do not have the Schedule and Configuration
Manager features.
Adding due date alerts using the Assignment Calendar:
1. Click on Assignment Calendar from the course menu
2. Click Modify and select Manage from the dropdown located at the top right
of the page. A Lightbox window will open and list all assignable items in the
left hand menu.
3. To set a due date alert for an item, the click on the assignment (in the left
column of the Lightbox) and then click on the desired due date.
4. The due date is set and a clock appears to the right of the content item.
Note: The clock only appears in this Lightbox, not next to the content item when
accessed through the course’s left navigation menu.
5. When an activity is due within the upcoming week, an alert will show in the
―Upcoming‖ area of the Course Home.
To view assignments and their due dates on the Assignment Calendar, users can
choose to see assignments organized in a List, Month, or Term view. To go into
the past or future of the List and Month views, click the arrows to the left and right
of ―Today‖. Notice the arrows gray out at the beginning or the end of the course
so the calendar cannot go beyond the course dates.
Note: Students can click on the assignment name in the calendar to link directly
to each assignment in addition to accessing the assignment by clicking on the item
in the course menu.

Registration
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How to Assign Assessment Items (Test Bank Activities)
The Test Bank Activities in your course are found in the Chapter
Test Bank menu item and are automatically hidden by default. The
activities act as a standard assessment, but must be unhidden in
order for students to access them.
To unhide a Test Bank Activity,
1. Click the Modify link above the Course Menu.
2. Click on the Settings Tab, find the Test Bank menu item and uncheck the
"hidden" column.
Keys for Success: Be careful when editing Test Bank activities. Once you delete
a question, it is permanently deleted from your course.
Best Practice: Use the TestGen application with the downloadable testbank for
your book in order to create exams covering multiple chapters or to create
additional tests or quizzes for any chapter. See Import Tests/Quizzes from
TestGen for more information.
Would you like to restrict the window of time an assessment is available? Allow a
student to take it more than once? You can easily manage these settings using the
Scheduling and Configuration settings with the activity assignment manager.
Using the Schedule and Configuration feature within the activity
Assignment Manager
The Schedule Setting of an Assessment menu item will allow you to set an
availability window, set a time limit, allow repeated attempts, customize the
assessment display, and display of students’ scores.
Note: If you don't schedule an assessment, it is available right away. You can also
schedule a review date for an assessment—the date when the assessment results
become available to your students.

Registration

To schedule an assessment:
1. Click the assessment menu item, and click Manage Assessment.

Course Set-up
Gradebook

5. Specify whether to display grades by selecting one of the following:
 Display grade without answers on Review Date. Displays the
students' grade without showing correct answers to missed questions.
 Display grade with answers on Review Date. Displays the
students' grade and correct answers to missed questions, as well as
feedback.
6. Click Save.
7. At the confirmation prompt, click OK.
8. In the upper right, click (close) to hide the Schedule settings.

Student Experience

The assessment’s availability window will now be displayed on the Assignment
Calendar on the Available from and Due date.

Course Mgmt.
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Note: To allow students to view feedback on the same day the assessment is first
available, you can leave this as the default date already listed in your course (past
date).

Navigation

2. Click Schedule above the assessment.
3. To set the availability of your assessment:
 Click the calendar icon
for Available from to select the first date
that students can access the assessment.
 Click the calendar icon
for to to select the last day students can
access the assessment.
4. To set a review date when students can view their grades for this
assessment, click the calendar icon
for Review Date to select a date.

Adding an Introduction to an Assessment
You can also add an introduction note to students on any assignment that will
show up after the student clicks on the assignment menu item, but before
launching the actual assignment.
To add an introduction note:
1. Click your Assessment menu item and click Manage Assessment.
2. Click Introduction above the assessment.
3. Enter the message in the text box
4. Click Save

Best Practice: Use the introduction for not only instructions, but also
suggestions, hints or additional information that your students may find helpful as
they are completing the assessment.
To configure an assessment:
1. Click your Assessment menu item and click Manage Assessment.
2. Click Configuration above the assessment.
3. For Exam Features, click an option's check box to enable it:
 Student can take this exam multiple times. Clear this option to
ensure that students take the assessment only once.
Note: if a student can take the assessment multiple times, when it is
retaken, the previous scores will be completely deleted.
 Set time limit: Enter a value for the number of minutes students
have to complete the assessment.
 Save answers and end assessment when time limit is reached.
Check this checkbox for all timed assignments to assure a firm
deadline for the assessment. Clear this option to allow students extra
time to complete it.
 Create assessment with multiple pages. You can choose to have
one section per page or one question per page.

Registration
Course Set-up

4. For Results Features, select one of these options:
 Display score to student and post to gradebook. This selection
will provide immediate results for students. Select this option when the
assessment consists of all auto-graded question types. This score does
not include essay and short answer results.
 Hide score from student and don't post to gradebook. Results
are not provided to students or displayed in your gradebook.
5. Click Save.
6. At the confirmation prompt, click OK.
7. In the upper right, click (close) to hide the Configuration block.

Navigation
Gradebook

Your MyLab course includes two unique types of writing assignments that allow
you to assign writing exercises and to have students draft, complete, and submit
their responses right in your course.


Assisted-graded Writing Assignments assess a student’s understanding
of key learning objectives covered in each chapter, often based on the
book’s end-of-chapter content. Each assignment has a clickable grading
rubric to assist you as you review student responses.
Auto-graded Writing Assignments cover broader overall course learning
objectives, such as ethics, communications, or management skills. Each
student response is scored instantly according to a five-trait rubric specific to
the assignment.

Student Experience
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For both types of writing assignments, you can review the student’s work, provide
feedback and comments on their writing submission, and assign or adjust grades,
as desired.
Visit www.mymislab.com

Assignments

Registration

Using Writing Assignments in your Course

Assisted-graded Writing Assignments assess a student’s understanding of key
learning objectives covered in each chapter. The content for each chapter includes
two essay writing assignments and one comprehensive writing assignment, for
which students can submit written responses.
Each assignment has a clickable
grading rubric to assist you as
you review student responses.
Pre-built rubrics are provided for
you to use as is, or you can copy
a rubric and customize it to
create your own rubric. Any
rubrics that you create or
customize are available to you
across all your writing
assignments.
You also can add instructions and links to resource materials into your assistedgraded writing assignments. Your students will have access to the instructions and
links as they work in the writing assignment editor. To learn more about setting up
an assisted-graded writing assignment, see How to Set Up and Assign Writing
Assignments.
Auto-graded Writing Assignments cover broader overall course
learning objectives, such as ethics, communications, or management
skills. Auto-graded assignments are well-suited for students who can
work on their own to increase their skills. Auto-graded assignments
give students immediate, automated feedback on their writing without
your involvement.
For each auto-graded writing assignment,
you select a pre-defined assignment topic
that has its own instructions and rubric.
After your students submit an essay, the
automated process evaluates whether the
essay fulfilled the assignment directions
and returns scores for five writing traits
based on a rubric. The feedback also
provides students with links to
descriptions of the traits.
You have the option of returning a
student's submission for a rewrite,
entering additional feedback, and overriding the service's score before returning
the grade to the student. To learn more about setting up an assisted-graded
writing assignment see How to Set Up and Assign Writing Assignments.

Registration
Course Set-up

You also can create your own writing assignments based on exercises you
have created. When you create your own assignment, you can add your own
instructions, as well as any assignment resources, checklists, or sample
documents. Finally, you can choose to use an existing pre-built rubric or create
your own.
As with the assisted-graded writing assignments, students will have access to the
instructions and links as they work in the writing assignment editor. To learn more
about setting up an assisted-graded writing assignment, see How to Set Up and
Assign Writing Assignments.

Gradebook



Assisted-graded Writing Assignments are located in Course Content for
each chapter. Each chapter has an End of Chapter: Assisted-graded Writing
Exercises folder, which includes two essay writing assignments and one
comprehensive writing assignment, for which students can submit written
responses.
Auto-graded Writing Assignments are located in a Writing Space folder
under Instructor Resources.

Assignments



Registration

Before starting the steps below, first locate the specific writing assignment you
wish to assign in the left course navigation:

Navigation

How to Set Up and Assign Writing Assignments
The process for setting up assisted-graded or auto-graded writing
assignments is similar: you use the same screens, but how you
respond to some of the prompts depends on the assignment type.
For example, an auto-graded assignment fills in its own instructions
and rubric, but you would specify that information for an assistedgraded writing assignment. The following sections outline the
appropriate prompt responses for the various assignment types.

Student Experience
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After you have selected the desired assignment, complete the following steps to
set up the writing assignment.
1. The Details tab provides option for you to customize the assignment and set
a due date for students. Many of these settings are pre-set and do not need
to be changed, as outlined
below.
 In the Assignment
Name box, you
optionally can edit
the assignment
name that displays
to your students.
 The Auto-scored
Assignment option
will already be set:
for assisted-graded
assignments, the
option is set to
None. For autoscored assignments,
do not change this
setting.
 To set a Due Date,
click the calendar
icon, select a due
date from the
calendar, and then
click Done. Any
assignment submitted after 11:59:59 p.m. Eastern time on the due
date is flagged as late. (Note: This will not feed to the assignment
calendar).
 The Writing Environment option determines whether students are
to submit their writing in the editor or in a separate file. When you
select File Upload, the Allowable File Types display, showing the file
types you will accept (.doc, .docx, .pdf, by default). To change the
file types you'll accept, click the Edit List button, select the types
you want, and click the Save button. Note that Auto-graded
Assignments only can be submitted online at this time.
 The Instructions box is pre-populated with the question text and
instructions. For an Assisted-graded Writing Assignment, you can
edit the assignment instructions. You cannot modify the instructions
for an Auto-graded Writing Assignment; these are pre-defined so
that the grading system can assess the writing submission against
these instructions.

Registration
Course Set-up
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2. You use the Resources tab to add supplemental links and a checklist to a
writing assignment. Students can access these resources in the Tools bar as
they are working in the editor. There are three types of supplemental
materials:
 Assignment Resources are links to websites that students can
use while completing a writing assignment. To create a link to an
assignment resource, enter the Resource Label, which is a title for
the website, and the full URL to the site (for example,
http://www.pearson.com/).
 A Sample Document can be used as a reference for students.
Before you can link to a sample document, you must first upload it
to a website where it has a unique URL (such as the Public folder of
a Dropbox account or a specific location in your course website). To
create a link to the sample document, enter the Sample Document
Label, which is a name for the document, and the full URL to the
document (for example,
http://www.pearson.com/writingassignment1.doc)
 A Checklist is
reminder of tasks
you expect
students to do
for this
assignment.
Students can
view the
checklist as they
work in the
editor. Students
also will see the
checklist again
as they start to
submit a writing
assignment. Each
writing
assignment has a
default checklist
that you can
keep, edit, or
delete.

To schedule writing assignments and add them to the assignment calendar:
1. For Auto-graded Assignments, move the writing assignment menu item
outside of the hidden Auto-graded Writing Assignments menu item and
"Unhide" the assessment. To do this:
 Click the Modify link above the Course Menu and click the Add and
Arrange tab.
 Reorder the Writing assignment Menu into a chapter folder or other
location outside of the hidden Writing Space > Auto-graded Writing
Assignments Parent Menu item (See Order Items for instructions on how
to reorder content).
 Click on the Settings Tab, find the Writing assignment Menu item in its
new location and uncheck the "hidden" column.
Note: you do not have to complete this step for Assisted-graded Writing
Assignments; they are not hidden.
2. Next, add Due Date Alert via Assignment Calendar on the date for which the
assignment is due, based on what you set in the Details tab. For more
instructions, see Adding due date alerts using the Assignment
Calendar.
Review and Comment on Student Submissions
As students submit their essays, you can review and comment on them.
Depending on your preference, you can review, enter feedback, and grade essays
in one pass or in multiple passes. As you work through each step, the Status
setting on the Students tab tracks where each submission is in the process.
Auto-Graded Writing Exercises

Assisted-Graded Writing Exercises

Registration

To start the process of reviewing a student’s writing assignment, click the
Grade/Review button on the Assignment Details tab.

Course Set-up

As you review the assignment, enter your comments to the student in the editor.
Your comments are saved on the most recent Feedback tab. Click the Save button
to save your feedback and change the submission's status to Reviewed, which
indicates that it’s partially reviewed. When your review is complete, click the
Commenting Complete button to save your changes and indicate to students that
your review and comments are complete.
For more information, see:
 Review and comment on a writing submission completed in the
editor
 Review and comment on a writing submission with an uploaded file

Navigation

Note: For Auto-graded assignments, the review process is automated, so you can
move directly to review and grading. For more information, see Grade Writing
Submissions.
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As you review assignment submissions, you may find some that you want to
return to students for a rewrite. For example, a student may have misunderstood
the instructions or may have submitted the assignment to you accidentally, before
it was finished. In those cases, you can click the Return for Rewrite button to
return for the assignment back to the student. For more information, see Return
a submission for rewrite.

Grade Writing
Submissions
After students have
completed their writing
assignments, you can
review them one final
time and then assign a
grade. For an
Assisted-graded
Writing assignment
with a rubric, click the
Grade & Rubric icon
under Tools and then
select a rating in the
rubric, based on your
evaluation of the
student's response.
The rubric calculates
and displays the trait's
percentage Score and
adjusts the Rubric
Grade accordingly. You
can override the rubric
and enter a grade as
the Adjusted Grade.
For Auto-graded Writing Assignments, the automated process evaluates and
assigns rubric ratings automatically. To review the ratings, click the Grade &
Rubric icon under Tools and then review and override the automated grades as
desired. Again, you can override the rubric and enter a grade as the Adjusted
Grade.
When your review is complete, click the Save Grade button at the bottom of the
rubric to save the scores and resulting grade. The Students tab changes the
student's status to Graded and displays the grade.
For more information, see:
 Review and grade auto-scored submissions
 Grade a writing assignment with a rubric
If you want to change a student’s grade at any time, you can rescore the
assignment using the rubric or you can simply enter a new grade. You can use this
procedure for both Auto-graded and Assisted-graded Writing assignments. For
more information, see Change a submission's grade.

Registration
Course Set-up

Release Grades and Feedback to Students
When you enter feedback and grade or change an assignment's score, the
feedback and grade are not automatically released to the students. This means
you can review and grade student submissions as they come in, and then release
them all at once. You can also release them in batches or individually. The only
difference is whether you select all, several, or one student to whom to release the
grades. You can select as many students as you want because the release process
checks the selections to see whether a student has a grade and whether that
grade was already released.

Navigation

Note: You must also use this procedure to return grades for Auto-graded Writing
assignments. Students receive feedback from the auto-score service, but not their
final grades.
To return feedback and grades to students:

Assignments

Registration

1. Select the student(s) for whom you want to release grades on the
Assignment Details page.
2. Click the Return with Grade button.
3. A report is displayed detailing the number of students whose feedback and
grades were returned. Click the close icon to exit the message.
4. The Students tab now displays the submission status as Returned to
Student for the applicable students.

Gradebook
Student Experience
Course Mgmt.
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Office 2010 Assignments: MyITLab
Under the Office 2010 Assignments: MyITLab item in the left navigation, four
submenu items are available:







Office 2010 Assignments is a student view area that displays any of the
additional MyITLab assignments you have assigned to your students.
Office 2010 Gradebook is the student view of the MyITLab gradebook.
MyITLab assignment and training grades will
not appear in the MyMISLab main
gradebook. Students will need to review their
MyITLab assignment grades here if you
choose to include MyITLab assignments in
your course.
Office 2010 Assignment Administration
provides instructor access to MyITLab
content via MyMISLab. Instructors create,
edit and assign any additional MyITLab
content for their course here.
Office 2010 Instructor Gradebook is the
instructor view of the MyITLab gradebook.
You can view submissions, delete
submisssions, and export your students’
MyITLab assignment grades from the
gradebook.

Using Office 2010 Assignments and Office 2010 Gradebook
The Office 2010 Assignments view allows students to access any MyITLab content
you have assigned to them, in addition to the MyITLab training exercises that map
to the Application Exercises and are available by default.
The Office 2010 Gradebook view allows students to see grades for any MyITLab
assignments you have made available in your course. If you choose to assign
additional MyITLab content in your course, you will need to unhide both the Office
2010 Assignments and Gradebook child menu items and make them available to
your students.
To unhide the Office 2010 Assignments and Gradebook child menu items:
1. Click the Modify link above the Course Menu.
2. Click on the Settings Tab, find Office 2012 Assignments: MyITLab and
uncheck the ―hidden‖ column. This makes all of the submenu items in the
Office 2010 Assignments: MyITLab menu item unhidden.
3. Be sure to re-check the ―hidden‖ columns for any child menu items that you
want to keep hidden, such as Office 2010 Assignment Administration and
Office 2010 Instructor Gradebook.

Registration
Course Set-up

Using Office 2010 Assignment Administration
This child menu item provides instructor access to MyITLab content and allows you
to create, edit and assign any additional MyITLab content for your course. From
this area, you can assign simulations or Grader projects and set scheduling options
and preferences for both.
MyITLab simulations available in MyMISLab include Office Fundamentals, Excel,
and Access simulations from our Exploring Microsoft® Office 2010 series. Three
kinds of simulations are available in MyITLab:

Navigation
Gradebook

All of these simulations are available as either Project-Based or Skills-Based
assignments. Skills-Based allows the students to skip around in the simulation and
complete the questions in any order; Project-Based requires the student to
complete the simulation questions in sequential order, as if they were completing
a project in Microsoft Office.

Student Experience

MyITLab automatically grades the student’s simulations and records the results in
the Office 2010 Gradebook.
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1. Study Plans that allow
students to take a pre-test,
review training based on the
skills they got wrong in the
pre-test, and then complete a
post-test for final evaluation.
2. Exams that provide two
different scenarios – Scenario
1 and Scenario 2 -- to allow
for multiple assessment
options.
3. Trainings that include
simulations with step-by-step
tutorial help for students.

To add a simulation activity to your course:
1. Click the Office 2010 Assignments: MyITLab menu
item in the left navigation and then click the Office 2010
Assignment Administration child menu item.
2. In the Course Materials Library, click the Office 2010
Assignments folder.
3. Click the folder for the application you wish to use and
then click to open to the appropriate chapter.
4. Click to open the Activities folder and locate the simulation activity or
activities you want to assign. Click the checkbox next to the activity or
activities.
5. Click the Add button to add the assignment to your course. The activities
will display in the My Course area on the right side of the screen.

6. If you are prompted to Set Scheduling Options, you can do so at that time or
access the activity later to set those options.
7. Note that newly added activities may be hidden by default. To unhide an
activity, click the checkbox next to the activity and then click Show/Hide.
Note: To help you organize your additional MyITLab assignments and for easy
access by your students, create a folder in My Course and organize the
assignments in that folder. To create a new folder in My Course, click Add Course
Materials in the My Course area and then click Add Folder. Enter a name and
description that will be easy for you and your students to understand.
After adding a simulation activity, you may add or delete questions or change
other options based on student feedback or your experience.

Registration
Course Set-up
Navigation
Gradebook
Student Experience

MyITLab Grader projects are live-in-the application projects based on Excel and
Access projects from our Exploring Microsoft® Office 2010 series. Your students
will complete the project live in the Office 2010 application and submit it for
immediate grading. The process is as easy as 1-2-3. To complete a Grader project,
a student:
1. Downloads the required files from the project screen.
2. Completes the assignment in Microsoft® Office 2010.
3. Uploads the finished assignment file.

Course Mgmt.

Join us! www.mybschoolcommunity.com

Experience

Visit www.mymislab.com

Assignments

Registration

To edit a simulation activity in your course:
1. Navigate to the desired activity in the My Course area on the right side of
the screen. Point to the activity name, click on the Options dropdown menu,
and then click Edit.
2. On the Activity details tab, you can edit the name of the activity, add or
edit the description, and set the estimated time to complete the activity.
3. The Questions tab allows you to add questions by clicking Add Questions
and selecting additional content from the Question Library. You can also
adjust the number of points for a question by clicking the Options menu for
the question and then clicking Set point. Enter the new score for the
question and then click Save and Close.
4. On the Messages tab, you can add a message to display to your students at
the beginning and end of an activity.
5. The Grades tab allows you to select a grading schema to apply to student
grades. If desired, you can add a new schema from this tab.
6. The Preferences tab allows you to set a number of options for an activity,
including:
 Attempts/Timing options, which allow you to specify how many
times the student may launch or take the entire exam, the time
limit for the activity, and late submission settings.
 Others options, which allow you to set the Trap (ALT+TAB)
function so that a student is unable to display another browser
window during an exam. By default, this preference is turned on.
You can use Play in Training Mode to change an exam to a training.
The Allow Student to Save for Later option allows a student to save
an exam before completing it and then return to complete it later.
 Shuffling options that allow you to set how questions are shuffled
within an exam.
 Grading options that allow you to specify which score to display in
the Gradebook (highest, lowest, first or last), to indicate a mastery
score, and to provide a class average.
 Feedback settings that that allow you to indicate if a student can
see clickstream data and completion methods in the gradebook.

MyITLab automatically grades the assignment and records the results in the Office
2010 Gradebook.
To add a Grader project to your course:
1. Click the Office 2010 Assignments: MyITLab menu item in the left
navigation and then click the Office 2010 Assignment Administration
child menu item.
2. In the Course Materials Library, click the Office 2010 Assignments folder.
3. Click the folder for the application you wish to use and then click to open to
the appropriate chapter.
4. Click to open the Activities folder and locate the Grader project homework or
assessment activities you want to assign. Click the checkbox next to the
activity or activities.
5. Click the Add button to add the assignment to your course. The activities
will diNsplay in the My Course area on the right side of the screen.
6. If you are prompted to Set Scheduling Options, you can do so at that time or
access the activity later to set those options.
7. Note that newly added activities may be hidden by default. To unhide an
activity, click the checkbox next to the activity and then click Show/Hide.

Note: To help you organize your additional MyITLab assignments and for easy
access by your students, create a folder in My Course and organize the
assignments in that folder. To create a new folder in My Course, click Add Course
Materials in the My Course area and then click Add Folder. Enter a name and
description that will be easy for you and your students to understand.

Registration
Navigation
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To set scheduling options for a simulation or Grader project:
1. Navigate to the desired activity in the My Course area on the right side of
the screen. Point to the activity name, click on the Options dropdown menu,
and then click Set Scheduling Options.
2. From this page, you can assign an activity, set an availability date range,
and specify a location for the activity to be completed.
3. After selecting the desired scheduling options, click Save.
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Office 2010 Instructor Gradebook
The Office 2010 Instructor Gradebook provides an instructor view
of the MyITLab gradebook, so you can see grades for any of the
MyITLab content you have assigned to students. You can export
your students MyITLab assignment grades from this area and
upload them into the main MyMISLab gradebook or your own LMS.
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Scheduling Options are available for all assigned simulations and Grader
projects. Using scheduling options you can set an assignment to be assigned or
unassigned; set the availability date range; determine if it an activity is available
to all students or just specific students; and define the locations where students
can access the activity.

Course Set-up

To edit a Grader project in your course:
1. Navigate to the desired activity in the My Course area on the right side of
the screen. Point to the activity name, click on the Options dropdown menu,
and then click Edit. The options to edit a Grader project are largely the
same as those for MyITLab simulations, with a few exceptions.
2. The Questions tab allows you to change the point values of a question in a
Grader project and determine if you want hints to show or not. To do this,
click the Options menu for the question and then click Edit. Click Manage
Variation Preferences to open it. For each step in that project, you can
change point values or add a pre-made hint to a task within a Grader
project. If a question is set to have 0 points, it will not impact a students
grade when they submit the Grader project. Click Save and Close when your
changes are complete.
3. The Preferences tab allows you to specify the number of attempts that
students are allowed to make on the assignment. Setting multiple attempts
allows the student to view the submissions, make corrections to the
document, and resubmit for grading.

To access and view grades in the Office 2010 Instructor Gradebook:
1. Click the Office 2010 Assignments: MyITLab menu item in the left
navigation and then click the Office 2010 Instructor Gradebook child
menu item.
2. Locate an assignment using the navigation options in the My Course panel at
the left side of the Gradebook. Notice that the Gradebook is organized using
the folders and subfolders that you create for your assignments. The
assignments and grades for all items in a folder appear in the right
Gradebook pane, with one column per assignment.
3. To view gradebook options for an assignment, click the Option buttons next
to the assignment name.
4. To view gradebook options for a specific student’s grade, click the grade to
view the Options button. Click the Options button.
5. If you want to filter the view of the gradebook columns to show only specific
assignment types, assignment status, or other options, click View Filters in
the left panel and then select the desired filters. Selecting Show Status for
All Items under Students allows you to quickly see if students have started
or completed any assignments.
6. To clear filters click the X next to selections at the top of the Gradebook.
Note: By default, Office 2010 Instructor Gradebook includes a student named
_student, _student. Because your instructor access to MyITLab allows you to
toggle between Instructor View and Student View, any grades for assignments you
complete in Student View are listed under this _student, _student account. While
grades appear in the gradebook, they are not included in any class average
calculations or reports.

Registration
Course Set-up

To view and/or delete student submissions in the Office 2010 Instructor
Gradebook:
1. Click the Options button next to the assignment name.
2. Click View all Submissions. A new window will open and display all student
submissions for that activity or assignment.
3. Clicking a student’s name in the left pane to view submission for an
individual student.
4. If a student has multiple submissions for an assignment, you can view each
submission by clicking the plus sign next to their name. You will then see all
submissions for that assignment and can click on an individual submission.
5. If you need to delete a student submission to reset it, click the Delete button
in the top right. Select This submission to delete a specific submission.
Select All submissions from this student to delete all of their
submissions. A student will be able to retake the assignment again.

Navigation
Assignments

Registration

Gradebook
Student Experience

Note: You also can view an individual student submission by locating a specific
assignment and student in the Office 2010 Instructor Gradebook. Click the grade
to view the Options button. Click the Options button and then click View/Grade
Submission.
Note: You also can view an individual student submission by locating a specific
assignment and student in the Office 2010 Instructor Gradebook. Click the grade
to view the Options button. Click the Options button and then click View/Grade
Submission.
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To export grades from the Office 2010 Instructor Gradebook:
1. In the Export area at the bottom of the gradebook, select whether to export
all grades, the current display, or the student roster.
2. Select the desired export format: csv file (which will open in Excel), tab
delimited file, pdf file, or Blackboard-MyLab/Mastering.
3. After selecting these options, click Download.

Registration

Gradebook

Course Set-up

Your MyLab course offers you a full-functioning gradebook to
manage all of your course grades in one place. In addition to the grades that
automatically populate into the gradebook, you can also manipulate and modify
individual student grades, mark assignments as extra credit, exclude assignments
from students’ grades, export grades to your learning management system, add
custom gradebook columns, and more.

Gradebook

Overview
This is the main view of the gradebook that lists all active students and all
gradable items in your course. From this view, you can add or edit any individual
grades including points, letter grade, comments, and decide whether or not to
share the grade with the student. You can also review the student’s submission by
clicking on View Details.

Assignments

Registration

Navigating your gradebook
Your gradebook has 3 main areas accessed by clicking on the modify link in the
upper right hand corner when your gradebook is opened.
 Overview
 Grade by Assignment
 Setup

Navigation

How the Gradebook works
All gradable items in your course are automatically represented by a gradebook
column. Activities and assessments that are auto-graded in your course will
automatically record to the Gradebook. If you have assignments that are
subjective in nature (short answer, discussion, or essay), they will have a column
in the gradebook, but require manual grading. You can also manually grade other
items you have identified as gradable or gradebook-only items to add points for
things like participation and attendance. There is also a Grade to Date Column that
will track each student’s cumulative percentage grade in the course.

Student Experience
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Note: After you have navigated to another view in the gradebook, you can always
return to the main Overview screen by clicking modify>Overview or by simply
clicking on the Gradebook menu item again in the left hand navigation.

Grade By Assignment
The Grade by Assignment view provides a snapshot view of each students’ scores,
letter grades, comments, and submission details for each assignment individually.
To navigate to the Grade by Assignment view:
 Click the modify link in the upper right hand corner of the content page
 Choose Grade By Assignment
You can select any assignment listed in the gradebook from the dropdown above
the grid of students and scores. From here, you can add or edit any individual
grades including points, letter grade, comments, and decide whether or not to
share the grade with the student. You can also review the student’s submission by
clicking on View Details. You can also navigate through the entire list of
assignments by clicking the Previous Assignment and Next Assignment buttons at
the bottom.
This is a great tool if you need to quickly assess your class results on a specific
assignment or if you need to add or edit grades for more than one student on the
same assignment.

Registration

Setup
The Setup view includes only assignment information and does not include any
student information. It lists all assignments that are listed in the gradebook with
the corresponding max point value of the assignment.

Course Set-up

To navigate to the Setup view:
 Click the modify link in the upper right hand corner of the content page
 Choose Setup
From this view, you can edit the max points of any assignment, mark an
assignment as extra credit, or exclude an assignment from the students’ grades.

Navigation

You can also choose to modify a gradebook item or add a new gradebook item by
using the buttons at the top of this view. The buttons will link you to the Modify
Course Menu lightbox where you can make changes and add items.

Registration

Assignments

Note: You can also add and modify items by going directly to the Modify Course
Menu lightbox from any place in your course by clicking the modify link above the
course menu.

Gradebook
Student Experience
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Add a gradebook item
1. Click Add New and the Modify Menu Lightbox will open to the Add &
Arrange tab.
2. Click Add new item to add an item to the main level OR expand the menu
item where you want the new item to reside (i.e. Course Content) and click
the Add new item link.
3. Select an item type from the dropdown. Any item type can be gradable. You
can select Assessment to create an exam with questions.
Note: You can select Gradebook-only Item to create a graded item that
you don't want included in the course menu.
4. Enter the Menu Item Name you want to appear in the course menu.
5. Checkmark Gradable.
6. For Points, enter the number of points you're assigning for the item.
Note: The point value will need to match the points associated with the
actual assessment. So be sure if you are adding questions that the total
points in the created assessment match the max points assigned here. (This
can also be edited later in the Gradebook Setup if needed)
7. Click Submission if you want students to complete and submit the item to
your Submissions area for you to review.
8. Select the Hide from students check box if you do not want the item to be
visible to students.
9. Click Save to add your new menu item, or Cancel to discard your changes.
10. Click the exit icon to close.
*Your new
gradebook item
has been added
to your
gradebook
and/or course
menu if
applicable.

Registration

Modify Gradebook Items
This feature will allow you to mark or unmark any item as hidden,
gradable, or submission. You can use other features within your
course to modify other aspects of the item.

Course Set-up

1. Click Modify Gradebook Items and the Modify Menu
Lightbox will open to the Settings tab.
2. Use the expand arrows to locate the assignment that needs modification.
3. Check or uncheck the boxes for hidden, gradable, or submission for any
item.
4. Click the exit icon to close.

Navigation
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Gradebook
Student Experience
Course Mgmt.

Join us! www.mybschoolcommunity.com

Experience

Visit www.mymislab.com

Enter student grades
You can enter student grades in the gradebook from both the Gradebook
Overview as well as the Grade By Assignment view of the gradebook.
Best Practice: Enter grades using the gradebook overview for a quick an easy
way to enter a grade for any student on any assignment. And use the grade by
assignment view for the best way to enter a group of grades for a single
assignment.
You do not have to enter grades for assessments (quizzes and exams). As soon as
students complete the quiz or exam, the scores appear in your gradebook.
However, if a quiz or exam includes essays and/or short answer questions, you do
need to grade these questions.
Tip: If you’d like to change a student’s score on an automatically graded
assessment, for example to give extra points or make a deduction, follow these
same steps.
To enter student grades in the Gradebook Overview on a per student basis:
1. Click Gradebook in the course menu.
Your gradebook appears with the following columns:
 Name: Lists student names alphabetically. The list of students is the
same as the course roster.
 Grade to Date: Grade average. The grade to date is calculated by
dividing the total points earned by the points attempted.
Note: If a student has not yet completed an assignment, that score is
not factored into the grade to date.
 Assignment columns: Each assessment and gradable item is shown
in a column. The number of possible points for each assignment is
shown beneath the assignment name.
2. In the row for a particular student, click the cell corresponding to a particular
assignment.
3. Enter the number of points the student earned in the Points text box.
4. (Optional) You can also enter a letter grade in the Letter Grade text box.
Note: The letter grade you assign does not get factored into the grade to
date. Only the point score is factored into the grade to date.
5. (Optional) Under Comments, type comments about the assignment. A
student will see your comments in the student gradebook.
6. Click Show to Student to share the grade and comments in the student’s
view.
7. Click Save or click View Details to view and edit the assignment details.

Registration
Course Set-up

View Details of Student Submissions
Once your students complete activities within the MyLab course,
you can review their attempt and add scores (in cases of items
needing a manual grade) and comments if desired by accessing
the item via your gradebook.
You can view the details of a student’s submission from both the
Gradebook Overview as well as the Grade By Assignment
view of the Gradebook. The details of the submission will allow you to review the
date taken, time spent on the assignment, number of questions, percentage and
raw score earned, as well as a breakdown of each of the questions and answers.

Gradebook

To review details from the Grade by Assignment view:
1. Locate the student. Click the arrow in the Details View column beside the
student’s name.
2. Scroll down the page to locate the assessment question. Click the arrow next
to it to expand the question. You will be able to see the student’s response.
3. There is a gray box at the bottom of the screen where you can add/change
the number of points received and add a comment to the student.
4. Click Save

Assignments

Registration

To review details from the Gradebook Overview:
1. Click Gradebook.
2. Locate the student and scroll to the activity column you wish to review
3. Left click on the dropdown next to the score earned
4. Click View Details.

Navigation

Keys for Success: Students will only see your
instructor comments if the ―Display grade with
answers on Review Date‖ option is selected in the
Schedule feature of the Manage Assessment area.
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Reset an Assessment
If you would like to allow a student to retake an assessment that
you had configured for only one attempt, you can reset the
assessment.
To reset an assessment item:
1. Click Gradebook.
2. Click the right Modify and select Grade by Assignment.
3. Select the assessment you want to reset, from the drop-down list of
assignments.
3. In the row of the student whose assessment needs reset, click Details
View.

4. Click Reset Student Assessment under Details.

5. Click Continue to clear the student's answers and results.
Note: Resetting an assessment will delete the previous submission and those
results will be irretrievable.

Registration
Course Set-up

Add Additional Time
If you need to allow additional time on an assignment on a per student basis, you
can choose to add additional time in one minute increments. Before you can add
additional time for any student, the student must launch and submit their first
attempt. Once a submission is received, you will be able to review the submission
and add additional minutes at that time.

Gradebook
Student Experience

Note: This will allow the student
back in to the entire assignment
and they will have the ability to
change previous answers as well
as answer incomplete ones.
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Best Practice: Use this feature to accommodate students who qualify for
additional time on assignments. Have the student use the initial allotted time and
submit. Then add additional minutes to extend the amount of time students have
to complete the assignment.
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5. Use the up and down arrows to adjust the additional minutes you wish to
grant the student
6. Click Grant
7. Click Ok on the
confirmation pop up

Navigation

To grant additional minutes on an activity:
1. Click Gradebook.
2. Click the right Modify and select Grade by Assignment.
3. Select the assessment you want to reset, from the drop-down list of
assignments.
4. In the row of the student whose assessment needs reset, click Details
View.

Export Student Grades
If you ever need your gradebook in spreadsheet form, you can Export your
students’ grades from the Gradebook. Exporting the grades will produce a CSV file
which can be opened in Numbers for Mac or Excel for PC.
1. Click Gradebook in the course menu.
2. Click the Export Gradebook button in the upper right corner of the
gradebook page.
Open the CSV file to see students’ First Name, Last Name, Email Address, and
Scores for each column from your gradebook.

Registration

The Student Experience (Question/Answer)

Course Set-up

Starting from the first day of registration through the final exam, it is likely that
you will field questions about your MyLab course from your students. To help you
and your students get answers quickly, we have compiled a list of frequently
asked questions that you might hear from your students as you progress through
the term and provided answers. Questions and answers are categorized by topicFirst Day of Class (Registration and Enrollment), Course Content, and Technical
Support.

Navigation

First Day of Class (Registration and Enrollment)

Gradebook

After I finished registering, I got a message that noted my registration
was being processed. Did I do something wrong?
No, during high traffic times, processing student registration can take longer. If
students receive this message at the end of registration, they should wait a few
minutes, then try signing into their account to make sure the course is listed.

Student Experience

How can I be sure that my computer is compatible with the MyLab
course?
Students can check the System Requirements listed on the Support tab of the
MyLab Home page. There is also a Browser check within the course on the Course
Home page that students can also use to check requirements.
Where can I find more information to learn how to use the MyLab in your
course?
There is a student user guide that walks students through registration, course
navigation, and getting help.
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What is the Course ID?
The first thing that the student is asked for in the registration process is the
instructor course ID. Your course ID is found below each course name in your
MyLab / Mastering New Design courses list.

Registration

Are there instructions for student registration?
Yes, Pearson provides First Day of Class (FDOC) materials for students found on
the Support tab of the Mylab homepage. These resources include:
 Step-by-Step Registration Instructions PDF
 Step-by-Step Registration Instructions PPT
 Student Registration Video Tutorial

I paid for MyLab access for this same book and edition last term, but
dropped the course. Do I have to repurchase access?
Students can enroll in additional course sections without additional payment, for
the life of the edition, as long as they already have a fully paid subscription for
that particular book/author/edition. Click here for more information on Additional
Course Section Enrollment.
I am waiting for my financial aid check before I can purchase MyLab
access, but I don’t want to miss any deadlines. What can I do?
Students can opt for Temporary Access during registration. This will give them
access to your course for 17 days without payment. Click here for more
information on temporary access.
How can I convert my temporary access to fully paid access?
Students have 2 ways to convert temporary access to fully paid. They will receive
three alerts via email indicating the time left before the access expires. Students
can click the link within the email and redeem an access code or pay with credit
card or PayPal. Students can also access the payment screen directly from their
account home page by clicking the ―Pay or use an access code now‖ link under the
course title and information. Click here for more information on converting
temporary access.

Course Content
I am not happy with my grade, how can I use MyMISLab to help me better
prepare for tests?
There are several self-study tools available in the MyLab course meant for
remediation that students can use on their own. You can refer them to the Study
Plan (Post-test has unlimited attempts), eText (if applicable), Interactive Lectures
and Flashcards.
How do I get the eText on my iPad?
Students can download the Pearson eText for iPad app and access the eText on
iPad either online or via download. The app provides many of the same features as
the browser based eText such as search capabilities, highlights, notes, and
bookmarks. There is a link in the Course Content of the course or click here for
more information and the link to the App Store.

Registration
Course Set-up

Why do I get a message that a subscription is required when I try to
access the eText?
There are 2 types of access to MyMISLab—with eText and without eText. If a
student purchased the non-eText version, they will get a message that a
subscription is required when they click on the eText link. From here, they can
choose to upgrade access and pay for eText access. If the student feels that they
have already paid for eText access and are still receiving this prompt, they should
contact Pearson Technical support.

Gradebook

Technical Support

Student Experience

I can’t seem to get registered for your course, what can I do?
Your student’s issue may be related to the course materials purchased. For
immediate assistance, students should contact our 24/7 Customer Support
(http://247pearsoned.custhelp.com) to obtain help getting registered and
logged in.
If it turns out that a student purchased the incorrect course materials, students
should contact Pearson Customer Service for assistance with purchasing options
and return policies:
http://247pearsoned.custhelp.com/app/answers/detail/a_id/6413/kw/
customer%20serv ice.
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Assignments

Registration

I submitted my assignment, but received a message that my results
would not be available until a future date. Can I see my score now?
In the Assignment Manager, you set a review date for each assignment. You have
the ability to choose to display the grade with or without answers on the review
date indicated. If the review date is after the submission date/time, students will
not be able to see results until this date. You have the ability to update this at any
time by editing the Schedule area in the Assignment Manager. See Assignment
Manager for more information.

Navigation

I would like another attempt on an assignment. Can you reset my
assignment so I can re-take it?
If you set an assessment to one attempt, students will not be able to re-launch the
activity after a successful submission. If you choose to allow the student to re-do
an assignment, you can reset an attempt which will delete the answers of the
students initial attempt.

I can’t open one of the assignments, what do I do?
For immediate assistance, students should contact our 24/7 Customer Support
to obtain help getting access to the material they need.
Students should also make sure that the computer they are using meets the
system requirements (listed on the support page of the MyMISLab website).
I am receiving an error message, what should I do?
For immediate assistance, students should contact our 24/7 Customer Support
(http://247pearsoned.custhelp.com) to report the exact error message
received and the steps they are taking before the error message appears.
Technical support agents can help the student troubleshoot the issue.

Registration

Course Management & Transition
Manage your Course Roster

Course Set-up

The course roster allows you to see a list of all of the students that
have registered and enrolled in your course. It displays the
student’s name, email address, current role, status, and temporary
access status (if applicable).
You can use the roster to view your full list of students, make a
student inactive in your course, view a student’s temporary access
status, promote an individual to the role of Section Instructor/TA,
and give permission for the Section Instructor to access and edit the course roster.
You can access your Course Roster from two places:

Navigation

your Course Home page:
Click the Course Settings link under that course title
Choose Course Roster from the dropdown
Review and/or make any changes to Role or Status
Click Save when finished or Cancel

Registration

From





Assignments

From your Courses list on your Account Home page:
 Locate the course you want to view
 Under the Course ID, click the
hyperlinked number next to
―students enrolled‖

Gradebook
Student Experience
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Active/Inactive Status
When a student successfully registers and enrolls in your MyLab course, they are
active. During the add/drop period, you might have students that drop the course
and need to be removed from your MyLab course. Removing a student from your
MyLab course is handled by changing the student Status to Inactive in the
course roster. This will remove the student from your gradebook and any class
averages.

Temporary Access Status
Students waiting on financial aid to make course material purchases can get
temporary access to your MyLab/Mastering course without payment for 17 days.
All students that chose to gain temporary access will have red text beneath the
student’s name indicating the status of the temporary access in the Course Roster.
There are two different states:
• Temporary Access Expiration Pending
• Temporary Access Expired
Temporary Access Expiration Pending:
• Red text is added beneath the student’s name notifying you of student’s
temporary course access and lists access expiration date.
• Student Role is un-editable, prohibiting any changes to student’s role for
individuals currently in temporary course access status.
Temporary Access Expired:
• Red text is added beneath the student’s name notifying you that temporary
course access has expired and lists access expiration date.
• Entire row is disabled, prohibiting any changes to student’s role or status.
Note: Students can change temporary access to fully active status at any time by
entering purchase information.

Registration
Course Set-up

Section Instructors/TAs (Optional)
Whether you are enabling another instructor to act as the Section Instructor to
your course or promoting a student to the role of Teaching Assistant (TA), you will
need to obtain a student access code for them. They will enroll as students, then
you promote them to section instructors from the course roster. When you update
the role to Section Instructor, you will also have the option to grant them
permission to access and edit the Course Roster.
You can obtain student access codes for section instructors from your sales
representative or from Pearson Technical Support.

Navigation

Note: The role Section Instructor is used synonymously for Teaching Assistant in
the Course Roster
Enable section instructors to access your course

Registration

Note: Only instructors can allow section instructors to access their courses—
section instructors cannot allow other section instructors to access courses unless
you grant them permission to edit the course roster.

Assignments

You can allow one or more section instructors to access your course. You would
use this option to add co-instructors to your course or if you have set up courses
in your own account to be taught by other instructors (i.e. adjuncts).

Promote a student to the role of Teaching Assistant (Section Instructor)
Gradebook

You can promote one or more students to Teaching Assistant (Section Instructor),
so they can help you perform tasks. This could include creating assessments,
managing the gradebook, or making other modifications to your course.
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Student Experience

Note: If the student registering as a teaching assistant is already enrolled in the
course as a student, he or she needs to register again with a NEW login name
using another Student Access Code. In this case, the teaching assistant will have a
student login name and a teaching assistant login name.

Manage Files
This feature offers you a repository for course documents and files. You can
upload, download, and organize materials by adding folders.
Note: This is an INSTRUCTOR ONLY feature. Students will
not be able to view or download documents or files you
upload to this area. If you want to share material with
students, you will use the Document Sharing feature instead.
See Document Sharing for more information.
To add new folders:
 Click Add Folder
 Enter Folder Name
 Click Add Folder or Save & Add Another Folder
Keys to Success: Don’t add files to Master Folder that should reside in
custom folders
You can upload files to the Master Folder, but if you want to organize your material
using custom folders, make sure that you create folders before uploading
documents as you will not be able to transfer documents from one category to
another after the upload is complete.
To upload a file:
 Click Upload Files
 Click Browse, select the file to be uploaded, and click Open
o If the selected file is a zip file and you want it unzipped as part of the
upload process, select Unzip .ZIP file.
 Click Upload File
To download a file:
 Click the checkbox next to the file(s) you wish to download, then click
Download Files
Note: You can select one or multiple files at once. When choose multiple
files, it will produce a .Zip file.


Open or Save the file(s)

Registration

Create/Copy Additional Courses and Sections

Course Set-up

You can create additional courses in a variety of ways. For
example, you can browse or search for course materials in the
catalog like when you created your first course or copy an existing
course from your own account or another instructor’s account.

Navigation

To create another course using the same course materials, you
can:
 Select the same textbook from the catalog to start from a fresh template
 Copy an existing course that you created
 Copy an existing course that another instructor created
Note: When you copy a course, the new course has a new course ID and an
empty course roster and gradebook.
To copy an existing course:

Gradebook
Student Experience

A Confirmation-Request Received page will provide you with your unique Course
ID for your new course. You can print this page for your records and click Back to
your Courses page.
On your MyLab/Mastering Courses page the clock icon indicates that your course is
being prepared. When your course is ready you will receive an email.
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Read further to learn why you might choose to copy courses!
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1. In the MyLab / Mastering New Design courses list, click Create/Copy
Course.
2. Select Copy a Course.
o Select Copy One of Your Existing Courses and select the course
you want to copy from the drop down menu.
o OR Select Copy Another Instructor’s Course and enter the course
ID (received from the other instructor) of the course you want to copy.
3. Click Go.
4. Specify course information.
(See Specify Course
Information for more info)
5. Click Create Course Now

Copy a course you created
There are a few reasons that you might want to copy a course you created:
1. Accommodate all of the sections you are teaching in the same semester
2. Copy a course from one semester to another when using the same
book/edition
When using the same book/edition from one term to the next, you will most
likely want to make a copy of your current course to take advantage of the
changes, organization, settings, etc that you have already set.
Note: When you copy an existing
course, your original course
remains untouched. Assessments
copied with the course retain the
same availability setting as in the
original course.

Copy another instructor’s
course
You may want to copy another
instructor’s course if you are
teaching a section of the same
course or planning to teach the
same course at a later date.
Copying another instructor’s
course allows you to take
advantage of the changes,
organization, etc that instructor
already set up. After you copy the course, you can customize it further.
Note: Assessments copied with the course retain the same availability setting as
in the original course set by the other instructor.
Keys to Success: Make sure the course you are attempting to copy has
been made available to copy
Before you can copy another instructor’s course, that instructor must make the
course available for copying and provide you with the course ID. If you try to copy
a Course ID from another instructor that is not marked ―available for copy‖ in the
course settings, you will receive an error. Click here to see how to edit the copy
settings of your course.

Registration

Make multiple copies or sections of a course
You can make multiple copies of an existing course from your own course list at
one time.

Course Set-up

If you are acting as a coordinator or program administrator, you will need to
create sections to accommodate the sections you and others are teaching.
To make multiple copies or sections of a course:

Navigation
Assignments

Registration

1. In the MyLab / Mastering New Design courses list, click Create/Copy
Course.
2. Select Make Multiple Copies or Sections of a Course.
3. From the list, select the course you want to copy and click Go.
4. In the Number of Courses box, enter the number of course copies you
want to create and click Update.
5. Edit the course and section names as needed.
6. You can change the Course Enrollment Dates and Course Duration for
all copies.
 After the course copies are created and appear in the MyLab /
Mastering New Design courses list, you can change the course
dates (and other course settings) for each individual course copy or
section by clicking Details next to the course name.
7. When ready to create your copies, click Create Courses Now.

Gradebook
Student Experience
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Course Expiration
When you originally create your MyLab course, you set a course end date. As the
course end date nears, you will notice
an hour glass icon next to your course
title in the courses list indicating the
course is about to end. When you see
this icon in your courses list, you have
two options:
1. If the course is still in use by registered students, you can extend the course
end date up to a maximum of 24 months from the course creation date (see
instructions below). Once the 24 months are up, the course enters a 3month retirement (inactive) phase, after which it is removed from the
system. If you have courses in the retirement process, you will receive three
consecutive email reminders, including instructions on how to preserve or
export your course materials.
2. If the course has ended and there are no active student users, you do not
need to take any action. The course will automatically start the 3-month
retirement phase 24 months after the course creation date.
To extend the Course End date:
1. From the Courses list, click
on the Details link to the
right of the course title.
2. Click on Edit Course.
3. Extend the Course End Date
(no longer than 24 months
after the Course Creation
Date).
4. Click Save.
Note: Once the three month retirement phase ends, the course will automatically
be deleted along with all assignments and student results.
Best Practice: Export your gradebook before your Course end date to preserve
all student grades/results from the course and make a copy of the course to
preserve the customizations you made to the course if you plan to teach the
course again in the future.

